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Einfuhrung

Erste Schritte mit Creo Parametric Import DataDoctor 1.0 ist eine Lernprogramm-
gestiitzte Einfiihrung, in der gezeigt wird, wie die Geometrie von Modellen
repariert wird, die aus externen Quellen in Creo Parametric importiert wurden. In
den Ubungen erfahren Sie, wie Import DataDoctor (IDD) die importierte
Geometrie behandelt, und lernen die besten Verfahrensweisen fiir eine schnelle und
effiziente Reparatur kennen.

In diesen Ubungen werden auch grundlegende Techniken zur Verwendung von
IDD-Tools vorgestellt. Wenn Sie mit diesen Verfahren vertraut sind, konnen Sie
Legacy- und externe Modelle in kurzer Zeit reparieren, dndern und als KEs
erzeugen. Das Endergebnis passt nahtlos in jede Creo Parametric Konstruktion, an
der Sie arbeiten.

Zielgruppe

Dieses Handbuch richtet sich an Konstrukteure mit Erfahrungen in der
Verwendung von Creo Parametric.

Umfang und Ziele

Dieses Handbuch kann keinen umfassenden Uberblick iiber alle IDD-Techniken
bieten. Ziel der Ubungen ist es, Sie mit dem Reparaturprozess vertraut zu machen,
damit Sie die Reparatur von Modellen effizienter bewiltigen. Viele kompliziertere
und erweiterte Techniken werden nicht erwéhnt. Zugunsten einer kompakten
Darstellung des gesamten Workflows fiir neue Benutzer wurden auch einige
grundlegende Techniken ausgelassen.
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Nachdem Sie ein Teilemodell (oder ein Teil aus einem importierten
Baugruppenmodell) in die Creo Parametric Sitzung importiert haben, verwenden
Sie Import DataDoctor (IDD), um Geometrie zu korrigieren, die Flachenkonsistenz
sicherzustellen, Randbedingungen hinzuzufiigen, unerwiinschte Spalte zu
schlieBen und die Tangentialitdt in den importierten Teilen nachzustellen.

In diesem Handbuch werden einige hiufig verwendete IDD-Techniken vorgestellt,
die zur Reparatur eines importierten Modells und zur Konvertierung des Modells
in ein Creo Parametric Modell benétigt werden. Nach dem Abschluss der Ubungen
sollten Sie in der Lage sein, externe Modelle zu reparieren, zu dndern und in Thren
eigenen Konstruktionen zu verwenden.

Hinweis
Die Beherrschung von Creo Parametric wird vorausgesetzt. In diesem Handbuch
werden nur spezielle IDD-Vertahren behandelt.



Vorbereitung

Import DataDoctor ist ein aufgabenorientiertes Reparatur-Tool, mit dem Sie
importierte Geometrie reparieren, dndern und als KE erzeugen konnen. Mit Hilfe
von Reparatur-Tools kdnnen Volumenkdrper aus der Geometrie erzeugt oder die
Qualitdt importierter Flichen oder Kanten verbessert werden. Bearbeitungs-Tools
unterstiitzen das Verschieben, Ersetzen und Bearbeiten von im Import-KE
vorhandener Geometrie. Tools zum Erzeugen von KEs konnen nicht analytische
Geometrie in analytische Geometrie umwandeln und Kurven und Flachen im
Import-KE erzeugen.

Laden Sie die Datei IDD Models. zip herunter, und extrahieren Sie die
Modelle, falls dies noch nicht geschehen ist. Der Link zu der ZIP-Datei und zu
diesem Handbuch befinden sich auf der gleichen Seite.

Aufgabenorientierte Reparatur

Die nachgeschaltete Nutzung der importierten Modelle bestimmt, in welchem
Umfang Reparaturen erforderlich sind. Wenn bekannt ist, zu welchem Zweck die
importierten Daten dienen sollen, miissen unter Umstédnden viel weniger
Reparaturen durchgefiihrt werden.

Importierte Modelle fallen in die folgenden Nutzungskategorien:

» Es sind keine Reparaturen erforderlich, wenn die importierten Modelle primér
als Informationsquelle fiir Produktstruktur, Modelleigenschaften oder
zugewiesene Massenwerte dienen. Eine importierte Sammelfldche kann ohne
Reparatur eine Platzbeanspruchung darstellen.

*  Volumenkdrpergeometrie ist zur Berechnung von Massenwerten erforderlich
oder zur Zeichnungserstellung erwiinscht. Sie konnen Informationsmeldungen
und Warnungen von Geometriepriifungen ignorieren.

* Qualitativ hochwertige Flachen sind fiir bearbeitete Komponenten, Spritzguss-
und Formkomponenten sowie andere nachgeschaltete Applikationen
notwendig. Sie miissen auf Warnungen und in bestimmten Féllen auf
Informationsmeldungen von Geometriepriifungen eingehen.

Importgenauigkeit

Die wihrend des Imports verwendeten Einstellungen konnen sich auf die
Ergebnisse auswirken. Genauigkeitseinstellungen spielen eine wichtige Rolle in
Bezug auf die Qualitdt der importierten Geometrie. Die Verwendung relativer
Genauigkeit zum Import kann qualitativ hoherwertige Importgeometrie ergeben als
die Verwendung der vom Unternehmen vorgeschriebenen Genauigkeitswerte. Bei
einigen Formaten kann Creo Parametric die Genauigkeit wéihrend des Imports an
die Genauigkeit der Dateien von Fremdherstellern anpassen. In der Regel fiihrt die
Anpassung der Genauigkeit zu besseren Ergebnissen. Fiihren Sie versuchsweise
Importe mit verschiedenen Genauigkeitseinstellungen durch, und wihlen Sie das
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Modell mit der besseren Qualitit. Andern Sie die Genauigkeit nach dem Import,
wenn andere Werte erwiinscht oder erforderlich sind. Die importierte Geometrie
wird nicht neu erzeugt und leidet daher nicht unter Anderungen der Genauigkeit
nach dem Import.

Die Benutzeroberflache kennen lernen

Import DataDoctor ist nur verfiigbar, wenn sich ein zuvor importiertes Creo
Parametric Teil in der Sitzung befindet und wenn dieses das aktive Modell ist.

So greifen Sie auf die IDD-Umgebung zu:

1. Klicken Sie im Modellbaum mit der rechten Maustaste auf das Import-KE, und
wihlen Sie im Kontextmenii den Befehl Definition editieren (Edit Definition),
oder wihlen Sie das Modell aus und wiéhlen Sie die Befehlsfolge Modell
(Model) » Operationen (Operations) > Definition editieren (Edit Definition).

2. Klicken Sie auf der Registerkarte Importieren (Import), die gedffnet wird, auf
, um die IDD-Umgebung aufzurufen.
Die Benutzeroberflache dndert sich wie folgt:

*  Der Geometrie- und Topologie-Strukturbaum (GTS-Baum) ersetzt den
normalen Creo Parametric Modellbaum.

» Die Multifunktionsleisten-Registerkarte Import DataDoctor (Import DataDoctor)
wird geoffnet.

Die Multifunktionsleisten-Registerkarte Import DataDoctor
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Die Multifunktionsleisten-Registerkarte Import DataDoctor (Import DataDoctor)
enthilt die folgenden Gruppen von Befehlen:

* Analysieren (Analyze) — Analysiert fehlerhafte Geometrie, die Qualitit von
Kurven, Abstand, Lédnge und Abweichwinkel und speichert die Analyse mit
dem Modell. Wertet die Kriimmung von Flachen sowie die Kurven- und
Flachenabweichungen aus.

Die Geometrieanalyse- und Messbefehle fiir Kurven und Fléchen sind die
folgenden:

o @ — Analysiert Kriimmung, Radius und die Tangenten von Kurven.

o — Analysiert die schattierte Krimmung von Kurven.

Import DataDoctor-Konzepte 9




@ — Analysiert die Abweichungen von Kurven und Flachen.
— Speichert die Analyse mit dem Modell.

— Misst den Abstand zwischen zwei Elementen.

— Misst den Abweichwinkel.

2| — Misst die Lange von Kurven und Flichen.

[ Geometriepriifungen (Geometry Checks) — Untersucht geometrische
Mingel.

Struktur (Structure) — Ermoglicht die Bearbeitung der topologischen Struktur
der importierten KEs und Knoten im Geometrie- und Topologie-Strukturbaum
(GTS-Baum). Sie konnen die Knoten bzw. die Geometrie der Knoten im GTS-
Baum aktivieren, abtrennen, aufteilen, kombinieren, zusammenfiihren,
verkleinern, einschlieffen, ausschliefen oder ausblenden. Konvertiert normale
Flachen in verfahrenstechnische Flichen wie Profilkorper, Drehkorper, Ebenen
und Zylinder.

Die Registerkarte Struktur (Structure) enthilt die folgenden Befehle:

O

U Aktivierung (Activation) » Aktivieren (Activate) — Aktiviert Knoten und
Flachensitze.

U Aktivierung (Activation) » Deaktivieren (Deactivate) — Deaktiviert
Knoten und Flachensitze.

|:| Abtrennen (Detach) — Trennt einen Satz von Unterknoten eines
Komponenten- oder Kombinationsknotens ab.

|:| Aufteilen (Divide) — Teilt Komponentenknoten auf.

|:| Kombinieren (Combine) — Kombiniert zwei oder mehr Knoten im GTS-
Baum.

Zusammenfiihren (Merge) — Fiihrt zwei beliebige Knoten zusammen,
die giiltige Sammelflidchen darstellen.

|:| Verkleinern (Collapse) — Verkleinert einen kombinierten oder vereinten
Knoten.

Konvertieren (Convert) » , @ , — Konvertiert in Zylinder,
Ebene, Profil-KE und Dreh-KE.

In vereintes Objekt konvertieren (Convert To Combine) — Konvertiert einen
zusammengeflihrten Knoten in einen kombinierten Knoten.

EinschlieBen (Include) — Schlief3t einen ausgeschlossenen Flichenknoten
ein.

AusschlieRen (Exclude) — Schlie3t einen Fldchenknoten aus.
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Bedingung definieren (Constrain) — Wendet Tangentialitit, Drahtmodell und
eingefrorene Randbedingungen auf die importierte Geometrie an. Definiert
Spalten und Splitter und fiigt sie zu Drahtmodellen hinzu. Friert Flachen ein,
um unerwiinschte Anderungen und Neuparametrisierungen, insbesondere
wihrend der Reparatur der Geometrie, zu verhindern. Fiigt
Tangentialbedingungen zu Drahtmodellen hinzu und entfernt sie aus diesen.

Die Registerkarte Bedingung definieren (Constrain) enthilt die folgenden
Befehle:

o Spalten/Splitter (Gaps/Slivers) — Definiert Spalte oder Splitter.
@ Einfrieren (Freezing) — Friert Flachen ein oder taut diese auf.

° Drahtmodell (Wireframe) — Fiigt Elemente der Drahtmodelldarstellung
hinzu oder entfernt diese.

© Tangentialitat (Tangency) — Fligt Tangentialitdt hinzu oder entfernt
diese.

Heilen (Heal) — Sucht und entfernt Spalte und Splitterflichen. Schlie3t Spalten
und entfernt unerwiinschte Splitterflichen aus den importierten
Sammelflachen. Repariert nicht erfiillte topologische Verbindungen,
Tangentialbedingungen und problematische Flachen. Verlédngert Flachen und
lasst diese tiberschneiden, um Berandungsschleifen zu fiillen.

Die Registerkarte Heilen (Heal) enthélt die folgenden Geometriereparatur-
Befehle:

© @I Reparieren (Repair) — Repariert nicht erfiillte topologische
Verbindungen und Tangentialbedingungen.

° Angleichen (Match) — Repariert problematische Flichen mit mehr als
vier Seiten, nicht erfiillte topologische Verbindungen und die zugeordneten
Tangentialbedingungen.

o SchlieRen (Close) — Repariert Drahtmodelle, schlie3t Spalte und
entfernt Splitterflichen in einem einzigen Vorgang.

Editieren (Edit) — Editiert die Geometrie von Flichen, Kanten und Kurven.
Verschiebt die Eckpunkte von Fldchen, bearbeitet und ersetzt
Flachenberandungen, konvertiert analytische Flachen in Freiform-Flichen,
andert die Eigenschaften der Freiform-Flichen und erweitert oder verkleinert
die natiirliche Doméne einer Fliche durch Extrapolation. Bearbeitet die
Konstruktionsabsicht der importierten Daten, die Transformation aus
Sammelfldchen, die KEs darstellen, und entfernt Sammelflachen, die KEs
darstellen.

Die Registerkarte Editieren (Edit) enthélt die folgenden Befehle:

o EI Eckpunkt bewegen (Move Vertex) — Bewegt Eckpunkte.

Import DataDoctor-Konzepte 11
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%
Kurven zusammenfiihren (Merge Curves) — Fiihrt Kurven und
Drahtmodelle zusammen.

@ Kurve trennen (Split Curve) — Trennt Kurven und Drahtmodelle.

EE Ersetzen (Replace) — Ersetzt einseitige Kanten und
Flachenberandungen schlechter Qualitat.

Eigenschaften (Properties) — Editiert die mathematischen
Eigenschaften von Flachen.

Andern (Modify) — Andert Kurven und Flichen.

I@ Extrapolieren (Extrapolate) — Extrapoliert oder verléngert die freien
Berandungen von Fliachen.

Ausrichten (Align) — Richtet Freiform-Fldchen sowie natiirliche und
nicht getrimmte Flichenberandungen aus.

IE Transformieren (Transform) — Transformiert Bezugs- und
Flachenknoten sowie komplexe Knoten und ihre Unterknoten im GTS-
Baum.

IE‘ Trimmen (Trim) — Trimmt Sammelfldchen und Flachen.

Verlangern (Extend) — Verldngert eine oder mehrere benachbarte
einseitige Kanten von Sammelfldchen.

Erzeugen (Create) — Erzeugt verschiedene Kurven, wie skizzierte Kurven, 3D-
Kurven durch Punkte und UV-Kurven durch Projektion und Uberschneidung,
durch Punkte und Isolinien. Erzeugt Berandungsverbundfldchen und
Bezugselemente, wie z.B. Bezugsebenen, Bezugsachsen, Bezugspunkte und
Bezugskoordinatensysteme.

Die Registerkarte Erzeugen (Create) enthilt die folgenden Befehle:

O

(0]

o

o

UV-Kurven (UV-Curves) — Fiigt UV-Kurven durch Projektion oder
Uberschneidung von Flichen, durch Punkte oder Isolinien hinzu.

@ Bezugsebene (Datum Plane) — Erzeugt Bezugsebenen.

@ Berandungsverbund (Boundary Blend) — Erzeugt
Berandungsverbundflachen.

E' Kurve durch Punkte (Curve through Points) — Erzeugt 3D-Kurven durch
Punkte.

4| Skizzierte Kurve (Sketched Curve) — Erzeugt skizzierte Kurven.

¢ Bezugsachse (Datum Axis) — Erzeugt Bezugsachsen.
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X

o ** Bezugspunkt (Datum Point) — Erzeugt Bezugspunkte.
by

£
O =" Bezugs-KSys (Datum Csys) — Erzeugt Bezugskoordinatensysteme.

Warum werden Definitionen editiert?

IDD dient der Definition von Geometrie. Wenn Sie jedoch ein importiertes KE
umdefinieren, sind auf der Registerkarte Importieren (Import) weitere Optionen fiir
die entsprechenden Aufgaben verfiigbar. Sie konnen folgende Aufgaben
ausfiihren:

Geometrie erneut laden — Sie konnen auf der Registerkarte Importieren (Import)
auf Datei (File) klicken und die Quelldatei erneut laden, um das Import-KE zu
aktualisieren, wenn Sie die Quelldatei nach dem Import gedandert haben oder
die Quelldatei &ndern, um die Geometrie der importierten KEs durch
Geometrie aus einer anderen Datei zu ersetzen. Die Geometrie aus der neuen
Datei erzeugt einen neuen Knoten im GTS-Baum. Sie kdnnen ein gesamtes
Import-KE durch Geometrie aus einer anderen Quelldatei ersetzen, die
Geometrie des Import-KEs konnen Sie jedoch nicht selektiv ersetzen oder dem
Import-KE Geometrie selektiv hinzufiigen.

Geometrie hinzufiigen — Sie konnen auf der Registerkarte Importieren (Import)
die Befehlsfolge Optionen (Options) » Aus Datei hinzufiigen (Add From File)

wihlen und im Dialogfenster Aus Datei hinzufiigen (Add From File) auf Quelle
(Source) klicken, um die Geometrie einem Import-KE aus einer anderen Datei

hinzuzufiigen, ohne die Quelldatei zu dndern. Die Geometrie aus der
ausgewdhlten Datei erzeugt einen neuen Knoten im GTS-Baum. Das
Bearbeiten der Geometrie des neuen Knotens in IDD ist optional. Sie konnen
die Flachen und andere Elemente in der vorhandenen Geometrie 16schen und
Flachen und andere Elemente aus dem neu hinzugefiigten Knoten bewegen,
um sie zu ersetzen. AuBlerdem konnen Sie IDD zum Bearbeiten der nicht
bendtigten Daten im neuen Knoten verwenden und die neu hinzugefiigten
Flachen in die alten Sammelfldchen einfligen.

In Volumenkorper konvertieren — Sie konnen die Volumen-KE-Optionen auf
der Registerkarte Importieren (Import) verwenden, um Verbundvolumen aus
geschlossenen Volumen zu erzeugen und sie in Volumenkorper oder Flachen

zu konvertieren. Die Optionen zum Erzeugen von Volumenkdrpern ( = ) und

Flachen (IE) sind nicht auf der Registerkarte Importieren (Import) verfiigbar,
wenn die importierten KEs nicht mindestens eine einzelne geschlossene
Sammelflache enthalten. Wenn das vorhandene Modell aus Volumenkorper-

KESs besteht und wenn Sie die Optionen auf der Registerkarte Importieren
(Import) aufgerufen haben, um die importierte Geometrie in Volumenkdrper

oder Fldachen zu konvertieren, konnen Sie verwenden, um Material aus
dem vorhandenen Modell zu entfernen.
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Der Geometrie- und Topologie-Strukturbaum

Der Geometrie- und Topologie-Strukturbaum (GTS-Baum) dhnelt dem normalen
Creo Parametric Modellbaum. Die Geometrie des importierten Modells, wie
Flachen, Beziige und andere IDD-Geometrietypen, werden als logische
Sammlungen von Mitgliedsknoten gruppiert. Jeder Knoten wird durch ein Symbol
gekennzeichnet. In der IDD-Online-Hilfe finden Sie Informationen dariiber, wie
viele der gingigen IDD-Operationen direkt an den einzelnen Mitgliedsknoten des
GTS-Baums ausgefiihrt werden, beispielsweise "Ausblenden" (Hide), "Aktivieren"
(Activate), "Zusammenfiihren" (Merge), "AusschlieBen" (Exclude),
"Ausschneiden" (Cut), "Kopieren" (Copy), "Einfiigen" (Paste) und "Umbenennen"
(Rename).

Darstellungsoptionen

Die Symbolleiste Grafiken (Graphics) in Import DataDoctor enthélt die folgenden
Anzeigeoptionen:

. — Drahtmodell-Randbedingungen

. EI — Gefrorene Zustande von Fliachen
. E — Eckpunkte

. — Tangentialbedingungen

Neben den Anzeigeoptionen enthélt die Symbolleiste Grafiken (Graphics) auch die

Auswahlfeld-Option (). Diese ermdglicht die Auswahl einer Geometrie in und
iiber einem definierten Rechteck.

Tangential- und Drahtmodell-Randbedingungen werden wéhrend des Imports
anhand der resultierenden Geometrie bestimmt. StandardméBig werden sie nach
dem Aufruf von Import DataDoctor nicht im Modell angezeigt, sie konnen jedoch
bei Bedarf ausgewéhlt werden.

Tangentialbedingungen sind topologisch definierte Verbindungen an den
Berandungen zwischen Flachen. Diese Randbedingungen werden vom System
automatisch an den Kanten generiert, die nach dem Import tangential oder nahezu
tangential sind. Erfiillte Tangentialbedingungen werden durch gelbe Pfeile
dargestellt. Schwarze Pfeile reprisentieren nicht erfiillte Tangentialbedingungen.
Tangentialitdt ist zum Erzeugen eines Volumenkdorpers aus einem Modell nicht
erforderlich, kann jedoch fiir die spétere Verwendung des Modells erwiinscht sein.

Eingefrorene Flachen werden durch einen weilen Kreis dargestellt, der den
Buchstaben "F" enthélt. Flachen mit mehr als vier Kanten werden vom System
eingefroren und konnen nicht manuell aufgetaut werden. Analytische Flichen
werden automatisch vom System eingefroren, Sie konnen diese Flachen jedoch
auftauen. Die Berandungen eingefrorener Fldchen konnen bearbeitet werden, die
Flachen selbst konnen allerdings nicht verédndert werden, solange sie eingefroren
sind.

™
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Wihrend des Imports werden zwischen den Liniensegmenten der
Flachenberandungen Eckpunkte erzeugt. Sie werden als gelbe Punkte auf dem
Modell dargestellt, wenn diese Darstellungsoption aktiviert wurde.

Drahtmodell-Randbedingungen sind topologische Verbindungen zwischen den
Kanten angrenzender Flichen. Diese Verbindungen konnen in den Quelldaten
definiert und von Creo Parametric importiert werden. Sie konnen beim Start von
Import DataDoctor automatisch erstellt oder manuell erzeugt werden. Erfiillte
topologische Verbindungen sind die gehefteten Kanten zwischen zwei Flachen und
werden als griine Drahtgitterkurven angezeigt. Schwarze Drahtgitterkurven stellen
nicht erfiillte bzw. unterbrochene topologische Verbindungen dar. Ein schwarzes
Drahtgitter kennzeichnet eine nicht geschlossene Bohrung im Modell.
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In diesem Kapitel importieren Sie ein Modell und lernen, wie mit Import
DataDoctor (IDD) grundlegende Reparaturen ausgefiihrt werden und wie das
Modell als normales Creo Parametric Volumenmodell mit Randdarstellung
gespeichert wird.

In dieser Ubung fiihren Sie folgende Schritte aus:

» Sie importieren und speichern ein fremdes oder Legacy-Modell (aus einer
STEP-Datet).
* Sie aktivieren Geometrie vor der Ausfiithrung von Reparaturen.

» Sie suchen und reparieren Spalte mit dem Such-Tool und dem Tool zum
Definieren von Spalten.

+ Sie Uberpriifen das Modell mit dem Fehlerbeheber auf geometrische Méngel.

* Sie fiigen einen Berandungsverbund hinzu, um eine offene oder fehlende
Flache zu schlielen.



Hinweis

Verwenden Sie fiir die Ubungen in den Kapiteln 2 und 3 jeweils eine Kopie der
urspriinglichen Modelldatei (basic probs w slvr.stp). Nachdem Sie
einen Spalt mit Hilfe einer Methode repariert haben, kann er nicht nochmals mit
einer anderen Methode repariert werden.

™
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Allgemeiner Arbeitsablauf des
Reparaturprozesses

In diesem Abschnitt wird ein Workflow fiir ibergeordnete Aufgaben des
Reparaturprozesses beschrieben. Er kann Thnen bei der Bewiltigung gangiger
Reparaturaufgaben helfen, jedoch nicht auf alle Reparaturaufgaben eingehen.

I.
2.

Rufen Sie die IDD-Umgebung von Creo Parametric auf.

Bereinigen Sie die Knoten im Geometrie- und Topologie-Strukturbaum (GTS-
Baum).

3. Aktivieren Sie einen Komponentenknoten implizit oder explizit.

Stellen Sie unter Verwendung der entsprechenden Darstellungsoptionen bei
Bedarf Drahtgitter, Eckpunkte oder den Status eingefrorener Komponenten dar.

Frieren Sie den aktuellen Komponentenknoten ein.

Hinweis

Sie konnen jederzeit wihrend der Reparatur den Komponentenknoten
aktivieren, die Darstellungsoptionen verwenden und den Komponentenknoten

einfrieren. Diese Schritte miissen nicht notwendigerweise in der gleichen
Reihenfolge wie in diesem Workflow beschrieben ausgefiihrt werden.

Konfigurieren Sie den Fehlerbeheber, und beheben Sie die identifizierten
geometrischen Méngel.

7. Beenden Sie IDD.

Erzeugen Sie einen Volumenkorper.

Modelle importieren

I.

Klicken Sie auf Datei (File) » E Offnen (Open). Das Dialogfenster Datei
offnen (File Open) wird gedftnet.

2. Wechseln Sie zu dem Verzeichnis, das die Modelle enthilt.

Klicken Sie unten rechts im Dialogfenster in der Liste Typ (Type) auf Alle
Dateien (*) [All Files (*)]. Die Datei basic probs w slvr.stp wird in der

Liste der Dateien angezeigt.

Doppelklicken Sie auf die Datei, oder wéhlen Sie sie aus, und klicken Sie auf
Offnen (Open). Das Dialogfenster Neues Modell importieren (Import New
Model) wird gedffnet.

Waihlen Sie Teil (Part) als Typ (Type) aus, und akzeptieren Sie den
vorgegebenen Namen, oder geben Sie einen neuen Namen ein.

Klicken Sie auf OK. Das Informationsfenster wird gedffnet, und das Modell
wird im Arbeitsfenster angezeigt.
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Hinweis
Um das Informationsfenster zu deaktivieren, legen Sie die
Konfigurationsoption int£3d show import log aufno fest.

7. SchlieBen Sie das Informationsfenster.

Modelldarstellungen einstellen

1. Sie kdnnen wahrend der Reparatur je nach Bedarf Bezugsebenen,
Bezugsachsen, Bezugspunkte, Bezugskoordinatensysteme und
Anmerkungselemente ein- und ausblenden, um das Modell tibersichtlicher
darzustellen.

2. Stellen Sie die Modelldarstellung auf Drahtgitter ein, damit geometrische
Elementfehler leichter zu erkennen sind.

Modell fiir grundlegende Reparatur

1 Spalte im importierten Modell

Import DataDoctor starten

1. Klicken Sie im Modellbaum mit der rechten Maustaste auf das Import-KE des
Modells (der vorgegebene Name ist Import Feature id xx), und wéhlen
Sie im Kontextmenii den Befehl Definition editieren (Edit Definition), oder

wihlen Sie das Import-KE aus und wéhlen Sie die Befehlsfolge Modell (Model)
» Operationen (Operations) > Definition editieren (Edit Definition). Die

Registerkarte Importieren (Import) wird gedffnet.

2. Waihlen Sie auf der Registerkarte Importieren (Import). Die
Multifunktionsleisten-Registerkarte Import DataDoctor (Import DataDoctor)
wird gedftnet, und der GTS-Baum ersetzt den Modellbaum. Jetzt befinden Sie
sich in der IDD-Umgebung.

™
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Den GTS-Baum verwenden

Im Beispiel unten enthélt das Import-KE unter Component 251 eine logische
Gruppierung von Flachen. Diese Gruppierung wird als Komponente bezeichnet
und entspricht einer Sammelfléche.

:ﬁ) Komponente 251
Flache 742

Hinweis
Jede unabhingige Sammeltldche im Import-KE wird im GTS-Baum als separate
Komponente angezeigt.

Das nichste Element im Baum ist surface 242, das nicht gruppiert wurde.
Diese Flache ist kein Bestandteil der Hauptsammelflidche. In diesem Beispiel ist
die einzelne Fliche im GTS-Baum eine zusammenfallende Fliche — eine doppelte
Fléche, die auf einer anderen Fliche liegt. Da sie zusammenfallend ist, wird sie im
Modell nicht verwendet und muss entfernt werden.

Zusammenfallende Flachen entfernen

Verwenden Sie das in den Schritten 1 bis 4 beschriebene Verfahren zum Ein-/
Ausblenden von Elementen, um die Geometrie einzelner Knoten im GTS-Baum
schnell zu untersuchen. Fiihren Sie die Schritte 5 und 6 aus, um die
zusammenfallende Flache zu entfernen.

1. Klicken Sie mit der rechten Maustaste im GTS-Baum auf component 251,
und wihlen Sie im Kontextmenii den Befehl Ausblenden (Hide). Component
251 und die zugehorigen gruppierten Flachen werden voriibergehend
ausgeblendet.

2. Klicken Sie mit der rechten Maustaste auf surface 242, und wihlen Sie im
Kontextmenii den Befehl Ausblenden (Hide). Im Arbeitsfenster wird jetzt
nichts angezeigt.

3. Wihlen Sie im GTS-Baum component 251 und surface 242 aus. Das
Modell wird im Arbeitsfenster als griines Netz dargestellt. Damit wird
angegeben, dass diese Fldchen ausgeblendet sind.

4. Wihlen Sie im GTS-Baum component 251 aus, und drehen Sie das Modell,
um die Fliche unter surface 242 sehen zu konnen. Da Sie tiberpriift haben,
dass das KE tatsédchlich eine Fliche enthélt, konnen Sie surface 242 jetzt
entfernen.
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Hinweis
Sie kénnen den Fldchenknoten ausschlieen und in der AusschlieBen-Ablage

platzieren, statt ihn zu I6schen. Klicken Sie mit der rechten Maustaste auf

surface 242, und wéihlen Sie im Kontextmenii den Befehl AusschlieBen
(Exclude), oder wihlen Sie auf der Registerkarte Import DataDoctor die

Befehlsfolge Struktur (Structure) » AusschlieBen (Exclude), um surface 242
aus dem importierten KE auszuschlieBen und abzutrennen und im
ausgeschlossenen Komponentenknoten zu platzieren. Zwar wird surface
242 im Arbeitsfenster nicht dargestellt, wenn sie ausgeschlossen wurde; sie
bleibt jedoch im Modell erhalten.

5. Klicken Sie mit der rechten Maustaste im GTS-Baum auf surface 242, und
wihlen Sie im Kontextmenii den Befehl Léschen (Delete).

1 Zusammenfallende Fldache 242, die entfernt wird

6. Klicken Sie mit der rechten Maustaste im GTS-Baum auf component 251,
und wihlen Sie im Kontextmenii den Befehl Einblenden (Unhide). Das Modell
wird im Arbeitsfenster ohne die zusitzliche Fldche angezeigt.

Geometrie zur Reparatur aktivieren

Vor dem Ausfiihren von Reparaturen miissen Sie zuerst Geometrie auswéhlen und
aktivieren, z.B. eine Komponente oder eine Gruppe von Fliachen einer
Komponente, wenn die Komponente grof3 ist. Beispielsweise konnen Sie eine
Gruppe von Flachen von component 251 auswéhlen und aktivieren.

Durch die Aktivierung von component 251 oder einer Gruppe von Fliachen von
component 251 werden der Umfang der Reparaturen auf den Bereich mit der
fehlerhaften Geometrie beschrinkt und Anderungen an der Geometrie verhindert,

™
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die nicht mit dem Fehler in Zusammenhang stehen. Die Aktivierung der
component 251 oder der darin enthaltenen Flachen ermdglicht auch die
Darstellung von Drahtmodellen, Eckpunkten und Tangentialitét.

Hinweis

Sie kénnen keine Flichen unterschiedlicher Komponenten gleichzeitig auswéhlen
und aktivieren.

Flachen aktivieren und Drahtgitter und Eckpunkte
anzeigen

1. Klicken Sie im GTS-Baum auf component 251, und erweitern Sie sie.

2. Waihlen Sie mit STRG + UMSCHALTTASTE surface 21 bis surface 43
aus, insgesamt fiinf Flachen.

[ KE-ID 5 importieren

v ﬂ Fomponente 251
Flache 0
Flache 21
Flache 27
Flache 31
Flache 37
Flache 43
Flache 49
Flache 55
Flache 59

3. Klicken Sie mit der rechten Maustaste auf die ausgewéhlten Flachen, und
wihlen Sie im Kontextmenii den Befehl Aktivieren (Activate). Bei den
gewihlten Flichen wird die Aktivierung wie folgt dargestellt:

[ KE-ID 5 impartieren

v :ﬁ) komponente 251
Flache 0
[ Flache 21
(4 Flache 27
[ Flache 31
(3 Flache 37
(3 Flache 43
Flache 49
Flache 55
Flache 559

4. Klicken Sie auf der Symbolleiste Grafiken (Graphics) auf , um
Drahtmodelle anzuzeigen.
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6. Klicken Sie auf der Grafiksymbolleiste auf EI, um die eingefrorenen Flachen
anzuzeigen. Im Modell werden nur fiir die aktiven Flachen, ndmlich surface
21 bis surface 43, wie dargestellt, die Drahtmodelle, Eckpunkte und
eingefrorenen Flidchen angezeigt.

== .
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Hinweis

Sie kénnen die Drahtmodelle, Eckpunkte und eingefrorenen Zustinde der
inaktiven Fldchen von component 251 nicht anzeigen. Sie miissen diese

Flichen aktivieren, um deren Drahtgitter, Eckpunkte und gefrorenen Zustinde

anzeigen zu kénnen.

7. Waihlen und aktivieren Sie einen weiteren Satz von inaktive Flachen,
surface 49 bis surface 73. Die eben aktivierten Flichen, surface 49
bis surface 73, werden wie folgt den in Schritt 3 aktivierten Fldchen

hinzugefiigt.

[ KE-ID 5 importieren

¥ :ﬁ) komponente 251
Flache 0
(4 Flache 21
(- Flache 27
(3 Flache 31
(- Flache 37
(3 Flache 43
(- Flache 43
[~ Flache 55
[~ Flache 59
(3 Flache 65
[~ Flache 69
(3 Flache 73
Flache 77
Flache &3
Flache &7

Im Modell werden, wie dargestellt, die Drahtmodelle, Eckpunkte und

eingefrorenen Flidchen angezeigt.

Ausfiihren von grundlegenden Reparaturen
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Geometrie deaktivieren

Sie konnen auf der Registerkarte Struktur (Structure) auf il Widerrufen: Aktivieren

(Undo: Activate) oder U Aktivierung (Activation) » Deaktivieren (Deactivate)
klicken oder mit der rechten Maustaste auf eine aktive Fldche oder einen Knoten
klicken und im Kontextmenii auf Deaktivieren (Deactivate) klicken, um die
aktivierte Flache oder den Komponentenknoten zu deaktivieren. Ebenso konnen

Sie auf der Registerkarte Struktur (Structure) auf T Wiederherstellen: Aktivieren

(Redo: Activate) oder U Aktivierung (Activation) » Aktivieren (Activate) klicken

oder mit der rechten Maustaste klicken und im Kontextmenu auf Aktivieren
(Activate) klicken, um den deaktivierten Flichensatz oder den Komponentenknoten
zu aktivieren.

1.

[ KE-ID' 5 importieren
v ﬂ bomponente 251

Flache 0

(3 Flache 21
(3 Flache 27
(4 Flache 31
(3 Flache 37
[ Flache 43
[ Flache 49
[ Flache 55
[ Fléche 59
[ Flache 69
(4 Flache 73
Flache 77
Flache 83
Flache &7

Waihlen Sie eine Teilmenge von Flachen innerhalb der aktiven Gruppe von
Flachen wie gezeigt aus. Das heif3t, Sie wihlen surface 31 bis surface
65 aus dem aktiven Flachensatz, surface 21 bis surface 73.

2. Klicken Sie mit der rechten Maustaste auf die ausgewéhlten Flachen, und

26

wihlen Sie im Kontextmenii den Befehl Deaktivieren (Deactivate). Nur die
ausgewdhlte Teilmenge von Flichen, surface 31 bis surface 65, wird
deaktiviert, die tibrigen nicht zum Deaktivieren ausgewihlten Flachen bleiben
hingegen aktiv (siche Abbildung).
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[ KE-ID' 5 importieren

v :ﬂ Homponente 251
Flache 0
(3 Flache 21
[ Flache 27
Flache 51
Flache 37
Flache 43
Flache 49
Flache 55
Flache 59

Flache 77
Flache 83
Flache 87

Komponenten aktivieren und Drahtgitter und
Eckpunkte anzeigen

1. Klicken Sie im GTS-Baum mit der rechten Maustaste auf den Knoten von

component 251, und wahlen Sie im Kontextmenii den Befehl Aktivieren
(Activate).

[ KE-ID' 5 importieren

Ld :ﬂ Homponente 251
Flache 0
Flache 21
Flache 27
Flache 31
Flache 37
Flache 43
Flache 49
Flache 55
Flache 59
Flache 65
Flache 63
Flache 73
Flache 77
Flache &3
Flache &7

2. Klicken Sie auf der Grafiksymbolleiste auf und E, um Drahtmodelle und
Eckpunkte anzuzeigen (siche Abbildung). In Griin dargestellte Drahtgitter sind

erfiillte Drahtgittermodelle, die schwarzen Drahtgitterdarstellungen sind
dagegen nicht erfiillte Drahtgittermodelle.

Ausfiihren von grundlegenden Reparaturen
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3. Klicken Sie auf der Grafiksymbolleiste auf EI, um die Darstellung
eingefrorener Flachen auszuschalten.
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4. Klicken Sie auf der Grafiksymbolleiste auf , um Tangentialitdt anzuzeigen

28

(siche Abbildung).
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Elternflachen von Drahtgittern auswahlen und
aktivieren

1. Klicken Sie im Modell mit der rechten Maustaste auf ein Drahtgitter.

.9"";“"‘&‘;_
/ f{ ; l'1

2. Klicken Sie im Kontextmenii auf Elternflachen wahlen (Select parent
surfaces). Die Elternflachen des Drahtgitters werden im Modell und im GTS-

Baum ausgewdhlt.

3. Klicken Sie mit der rechten Maustaste, und wihlen Sie im Kontextmenii den
Befehl Aktivieren (Activate), um die Elternflichen des Drahtgitters
auszuwihlen. Die Aktivierung der ausgewihlten Flachen wird im GTS-Baum
dargestellt.

Ausfithren von grundlegenden Reparaturen 29



Auswahlfilter zur Auswahl von Drahtgittern festlegen
Aktivieren Sie den Komponentenknoten oder die Flichen der Komponente, und

klicken Sie auf der Grafiksymbolleiste auf , um Drahtmodelle anzuzeigen. Sie
konnen dann den Auswahlfilter festlegen, um erfiillte und nicht erfiillte
Drahtmodelle und Drahtmodelle mit nicht erfiillten Tangentialbedingungen
auszuwihlen.

Flachen, Kanten, Kurven und Beziige sind andere geometrische Elemente, die mit
dem Auswahlfilter ausgewahlt werden konnen.

Wenn der Auswabhlfilter auf eine bestimmte Geometrie eingestellt ist, klicken Sie

auf der Grafiksymbolleiste auf , um ein rechteckiges Feld zu definieren und
Geometrie auszuwéhlen, die innerhalb oder {iber dem Feld liegt.

Die Komponente einfrieren

1. Klicken Sie im GTS-Baum mit der rechten Maustaste auf component 251.

2. Waibhlen Sie im Kontextmenii den Befehl Einfrieren (Freeze), oder wihlen Sie
die Komponente aus und wihlen Sie auf der Registerkarte Bedingung

definieren (Constrain) die Befehlsfolge Einfrieren (Freezing) >

Einfrieren (Freeze).

Spalte suchen, definieren und reparieren

Die Kanten der Flachen konnen zusammenfallen, ohne dass die Fliachen zu einer
einzigen Sammelfliche zusammengefiihrt werden. Der Grund hierfiir ist das
Fehlen topologischer Verbindungen. Solche topologischen Randbedingungen
verursachen Spalte zwischen Flachen, die in IDD repariert werden konnen.

Spalte zwischen Flichen bestehen aus Paaren von einseitigen Berandungen der
umgebenden Sammelfldchen. Jede Berandung verfligt {iber eine oder mehrere
einseitige Kanten von Flidchen. Daher definieren Spalte und topologische
Verbindungseinschrankungen, die auch als unerfiillte topologische Verbindungen
bezeichnet werden, Berandungsbedingungen.

Schwarze Drahtmodelle stellen die unterbrochenen Kanten dar, die als die nicht
erfiillten topologischen Verbindungen zwischen Flachen identifiziert werden.
Wenn der Spalt gro83 ist, sind zwei schwarze Drahtgitter sichtbar. Griine Drahtgitter
stellen erfiillte topologische Verbindungen dar.

Sie konnen automatisch nach Spalten suchen und sie mit dem Such-Tool
auswéhlen lassen, Sie konnen sie aber auch manuell im Modell auswéhlen.
Ungeachtet dessen, wie Sie die zu reparierenden Spalte ermitteln, miissen Sie die
ausgewihlten Spalte dem Drahtgitter hinzufiigen, um sie schlieBen zu koénnen.

™
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Spalte automatisch suchen

Wenn Sie Spalte im Modell mit dem Such-Tool suchen und auswihlen, miissen Sie
sie im Arbeitsfenster nicht einzeln auswihlen. Legen Sie mit dem Attributwert fiir
die Spaltgrofle Suchregeln fest. Die vom Such-Tool zuriickgegebenen Ergebnisse
basieren auf der von IThnen angegebenen Spaltbreite.

1. Wihlen Sie in Creo Parametric die Befehlsfolge Werkzeuge (Tools) »
Suchen (Find). Das Dialogfenster Such-Tool (Search Tool) wird gedftnet.

2. Waihlen Sie in der Liste Suchen nach (Look for) den Eintrag Spalte (Gaps) aus.

Legen Sie das Feld Wert (Value) auf 1 fest, und klicken Sie auf Jetzt suchen
(Find Now). GAP0001 und GAP0002 werden in der Liste Gefundene
Elemente (items found) angezeigt. Diese Spalte haben einen Wert von 1.
Hinweis

Das Such-Tool erkennt keinen Spalt im Modell, wenn der Standardwert fiir
Spalte beibehalten wird.

4. Waibhlen Sie diese beiden Elemente aus, und klicken Sie auf die
Pfeilschaltfliche, um sie in die Liste Ausgewahlte Elemente (items selected) zu
verschieben.

5. SchlieBen Sie das Dialogfenster Such-Tool (Search Tool). Die ausgewéhlten
Kanten werden im Arbeitsfenster wie in der folgenden Abbildung gezeigt griin
dargestellt:

1 Mit dem Such-Tool ausgewihlte Spalte
Hinweis
Zeigen Sie die Drahtgitter an, damit Sie sehen konnen, welche Drahtgitterspalte

erfiillt (griin dargestellt) und welche zwar definiert, aber nicht erfiillt sind (schwarz
dargestellt).

Standardspalte ermitteln

Das Such-Tool identifiziert keine Spalte im Modell, wenn unter Verwendung der
Standardspaltbreite nach Spalten gesucht wird. Der Grund hierfiir ist, dass die
Standardspaltbreite verwendet wird, um wahrend des Imports alle Spalte zu
identifizieren und zu korrigieren, und nach dem Import keine Spalte mit der
Standardspaltbreite im Modell vorhanden sind.
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Daher miissen Sie einen groBeren Wert als die Standardspaltbreite im Such-Tool
angeben, um Spalte im Modell zu finden. Wenn mit dem Such-Tool kein sichtbarer
Spalt identifizieren werden kann, konnen Sie auf der Registerkarte Bedingung

definieren (Constrain) mit der Befehlsfolge Spalten/Splitter (Gaps/Slivers) »
Spalt definieren (Define Gap) diese Spalte manuell definieren.

SchlieBen der Spalte

Nachdem Sie die Positionen der Spalte mit dem Such-Tool oder manuell ermittelt
haben, gehen Sie folgendermafen vor, um Drahtgitterkanten hinzuzufligen und die
Spalte zu reparieren. Wenn Sie dem Drahtgitter Kanten hinzufiigen und auf der

)
Registerkarte Heilen (Heal) auf Reparieren (Repair) klicken, werden die
definierten Drahtgitterspalte geschlossen.

— —
1. Wihlen Sie die Befehlsfolge Drahtmodell (Wireframe) » Zu Drahtgitter
hinzufiigen (Add to Wireframe) auf der Registerkarte Bedingung definieren

(Constrain). Die griinen Kanten werden schwarz dargestellt, wenn Sie sie dem

Drahtgitter hinzufiigen.

@

L 4

—

2. Wihlen Sie die Befehlsfolge Heilen (Heal) » Reparieren (Repair). Dic
Registerkarte Reparieren (Repair) wird gedffnet. Die reparierten Flachen
werden im Arbeitsfenster hervorgehoben.

3. Klicken Sie auf . Die Spalte sind jetzt geschlossen. Die reparierten Kanten
werden griin angezeigt.

Spalte manuell definieren

Jetzt definieren Sie die Spalte im Modell, indem Sie sie im Arbeitsfenster
auswihlen. Verwenden Sie die Abbildung in der Anleitung als Referenz.

1. Waihlen Sie auf der Registerkarte Bedingung definieren (Constrain) die
Befehlsfolge Spalten/Splitter (Gaps/Slivers) » Spalt definieren (Define

™
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Gap). Das Dialogfenster Spalte definieren (Define Gaps) wird geoffnet. Links
im Dialogfenster wird GAP0001 angezeigt.

2. Klicken Sie auf das Kollektorfeld Seite 1 (Side 1), und wahlen Sie die Kante A
(1-sided edge id 95) im Arbeitsfenster aus.

3. Klicken Sie auf das Kollektorfeld Seite 2 (Side 2), und wihlen Sie die Kante B
(1-sided edge id 191) im Arbeitsfenster aus.

Spalte definieren x

SPALTO00 seite 1

Meuer Spalt Elemente auzwahlen

Seite 2

Hier klicken, um Element hinzuzufigen

«  Zu Drahtmodell hinzufigen

Abbrechen

Klicken Sie auf Zu Drahtgitter hinzufiigen (Add to Wireframe).

Klicken Sie jetzt auf Neuer Spalt (New Gap), oder klicken Sie im Arbeitsfenster

mit der rechten Maustaste, und wéhlen Sie im Kontextmenii die Option Neuer
Spalt (New Gap).

6. Waihlen Sie die Kante C (1-sided edge id 95) aus, und klicken Sie mit der
rechten Maustaste. Die Kante wird im Kollektor Seite 1 (Side 2) angezeigt.

7. Klicken Sie auf das Kollektorfeld Seite 2 (Side 2), und wihlen Sie die Kante D
(1-sided edge id 181) aus. Die Kante wird im Kollektor Seite 2 (Side 2)
angezeigt.

8. Wiederholen Sie die Schritte 5 bis 7 fiir die Kanten E (einseitige Kante id 44)
und F (einseitige Kante id 89).

9. Klicken Sie auf OK. Die ausgewihlten Kanten werden im Arbeitsfenster griin
dargestellt.
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Hinweis

Zeigen Sie die Drahtgitter an, damit Sie sehen kénnen, welche Drahtgitterspalte
erfiillt (griin dargestellt) und welche zwar definiert, aber nicht erfiillt sind (schwarz
dargestellt).

Spalte schlieRen

Nachdem Sie die Positionen der Spalte mit dem Such-Tool oder manuell ermittelt
haben, gehen Sie folgendermalien vor, um Drahtgitterkanten hinzuzufiigen und die
Spalte zu reparieren. Wenn Sie dem Drahtgitter Kanten hinzufiigen und auf der

i)
Registerkarte Heilen (Heal) auf Reparieren (Repair) klicken, werden die
definierten Drahtgitterspalte geschlossen.

1. Wenn Sie das Kontrollkdstchen Zu Drahtmodell hinzufiigen (Add to Wireframe)
im Dialogfenster Spalte definieren (Define Gaps) nicht aktivieren, wéihlen Sie

auf der Registerkarte Bedingung definieren (Constrain) die Befehlsfolge L2
Drahtmodell (Wireframe) » . Zu Drahtmodell hlnzufugen (Add to Wireframe).

2. Wibhlen Sie die Befehlsfolge Heilen (Heal) » ¥ZZ Reparieren (Repair). Die
Registerkarte Reparieren (Repair) wird gedffnet. Die erzeugten Flachen werden
im Arbeitsfenster hervorgehoben.

3. Klicken Sie auf . Die Spalte werden geschlossen.

Das Schlielen von Spalten kann von der Reihenfolge abhéngig sein. Das heifit,
dass Sie moglicherweise einige Spalte erst schlieBen konnen, nachdem andere
Spalte geschlossen wurden. Sie miissen das Reparatur-Tool daher moglicherweise
mehrmals verwenden, um bestimmte Spalte im Modell zu schlieen.

Das Reparatur-Tool korrigiert beim Reparieren topologischer Verbindungen auch
die Tangentialitit. Schwarze Pfeile stellen unerfiillte Tangentialitdtsbedingungen
dar; wenn die Tangentialitét korrigiert wurde und die topologische Tangentialitét
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erfiillt ist, werden die Pfeile gelb. Ebenso werden schwarze Drahtgitter, die fiir
unerfiillte topologische Verbindungen stehen, griin, wenn die topologischen
Verbindungen erfiillt sind.

Obwohl es nahe liegend erscheint, auf Reparieren (Repair) zu klicken und das
gesamte Modell zu reparieren, miissen Sie beim mehrmaligen Einsatz des
Reparatur-Tools vorsichtig vorgehen. Griine Drahtgitter und Fldchen kénnen
verzerrt werden, weil topologische Tangentialitdtsbedingungen gleichzeitig
repariert werden.

Sie miissen die Flachen daher einfrieren. Allerdings kann die Tangentialitit nicht
repariert werden, wenn alle Fldchen im Modell eingefroren sind. Um unnétige
Anderungen an der Geometrie zu vermeiden, deaktivieren Sie das

Kontrollkdstchen Tangentialitat reparieren (Repair Tangency) auf der Registerkarte
Reparieren (Repair).

SchlielRen-Tool verwenden

Schwarze Drahtgitter lassen sich moglicherweise wegen unzureichend
ausgerichteter Eckpunkte am Ende von Spalten nicht schlieBen. Wenn Sie einen
Spalt mit dem Reparatur-Tool nicht schlieBen kdnnen und die Flachen des Spalts
nicht tangential sind, verwenden Sie das SchlieBen-Tool. Das Schlieen-Tool
verlangert die Flachen der Spalte, bis sie die Flachen schneiden, welche das
Drahtgitter umgeben.

1. Wihlen Sie das schwarze Drahtgitter aus.

2. Wihlen Sie die Befehlsfolge Heilen (Heal) » SchlieBen (Close).

Grunde fur das Hinzufigen von Spalten zu Drahtgittern

Sie miissen die im Modell identifizierten Spalte den Drahtgittern hinzufiigen, um
deren topologischen Verbindungen zu definieren. Das Reparatur-Tool verwendet
die topologischen Randbedingungen als Eingabe, um die Spalte zwischen den
Flachen zu schlieen.

Wenn Sie einen Spalt erneut suchen, nachdem er dem Drahtgitter hinzugefiigt
wurde, identifiziert das Such-Tool die zugehdrigen einseitigen Berandungen nicht
als Spalt, weil nach dem Hinzufiigen eines Spalts zum Drahtgitter eine
topologische Verbindung hergestellt wird.

Das Drahtgitter speichert die topologische Absicht und ermoglich Thnen, die Such-
und Reparatur-Tools mehrmals einzusetzen, um die topologische Absicht zu
erfiillen.

Hinweis
Es empfiehlt sich, das Drahtgitter vor dem Einsatz des Such-Tools oder dem
Definieren von Spalten zu untersuchen, da das Modell moglicherweise gar keine

Spalte enthilt. Stattdessen kann das Modell aus physischen Bohrungen ohne
topologische Verbindungen bestehen.
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Splitter identifizieren

Splitter konnen als Spalte betrachtet werden, die durch diinne Flachen mit hohem
Streckungsverhiltnis oder zusammenhingende Ketten von Flachen geschlossen
werden. Flachen mit hohem Streckungsverhiltnis sind lange und schmale Fléchen.
Dies sind Splitterflachen.

Eine Splitterflache sieht wie in dieser Abbildung aus.

——— —_
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Die hervorgehobene Fléache ist der Splitter.

| -
\ ‘ L
Splitter konnen in nachgeschalteten Applikationen, beispielsweise der Fertigung,

auch dann Probleme bereiten, wenn die Sammelflachen geschlossen sind. Ebenso
wie Sie Spalte den Drahtgittern hinzufiigen, miissen Sie daher die Splitter den
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Drahtgittern hinzufiigen, um topologische Verbindungen zwischen den
angrenzenden Flidchen zu erzeugen und die Flachen mit hohem
Streckungsverhiltnis zu 16schen.

Sie konnen dann mit dem Reparatur-Tool die physische Bohrung schlie3en, die aus
der Loschung des Splitters resultiert. Das Reparatur-Tool dndert die angrenzenden
Flachen derart, dass die neu erstellte topologische Randbedingung erfiillt wird.
Wenn kein Einsatz nachgeschalteter Applikationen geplant ist, konnen Sie die
Splitter im Modell belassen. Aus diesem Grund werden Splitter nicht
standardméBig identifiziert.

Modelle auf geometrische Mangel
uberprufen

Nutzen Sie das Diagnose-Tool, um fehlerhafte Geometrie und potenzielle

Problembereiche im Modell zu identifizieren. Das Diagnose-Tool ist iiber den
Fehlerbeheber (Troubleshooter) in Import DataDoctor verfiligbar.

Um den Fehlerbeheber (Troubleshooter) verwenden zu konnen, miissen Sie im
Dialogfenster Einstellungen fiir IDD-Fehlerbeheber die Geometriepriifungen fiir
das Modell aktivieren. Diese Geometriepriifungen bilden die Suchkriterien fiir die
Diagnose.

Diagnose- oder Geometrieprufungen einrichten

1. Wihlen Sie im GTS-Baum component 251 aus, und aktivieren Sie sie.

2. Wihlen Sie auf der Multifunktionsleisten-Registerkarte Import DataDoctor
(Import DataDoctor) die Befehlsfolge Analysieren (Analyze) » [H
Geometriepriifungen (Geometry Checks). Der Fehlerbeheber (Troubleshooter)
wird gedffnet.

3. Wihlen Sie im Fehlerbeheber (Troubleshooter) die Befehlsfolge Editieren
(Edit) » IDD-Einstellungen (IDD Settings). Das Dialogfenster Einstellungen fiir

IDD-Fehlerbeheber (IDD Troubleshooter Settings) wird gedffnet. Die Spalte
Diagnose (Diagnostic) enthilt alle fiir das Modell relevanten

Geometriepriifungen.

4. Waihlen Sie alle Geometriepriifungen aus, um die Diagnose fiir component
251 einzurichten.
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Emstellungen fiir IDD-Fehlerbeheber - 0 X
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0K Abbrechen

5. Akzeptieren Sie die Standardwerte in der Spalte Schwellenwert (Threshold) fiir
bestimmte Geometriepriifungen.

6. Klicken Sie auf OK, um die Einstellungen fiir die Geometriepriifungen und die
Schwellenwerte fiir das Modell in der Sitzung zu iibernehmen.

Diagnose fur Geometrieprufungen durchfuhren

1. Wihlen Sie im Fehlerbeheber (Troubleshooter) die Befehlsfolge Ansicht (View)
» Alle erweitern (Expand All), um den Knoten, component 251 und alle

Unterknoten zu erweitern. Den Unterknoten und Elementen innerhalb der
Unterknoten sind farbige Punkte vorangestellt, welche die Schwere der
geometrischen Mingel wie folgt angeben:

* Rot - Fehler
*  Gelb - Warnungen
* Blau - Informationen

2. Wihlen Sie Ttem 1 des Unterknotens Bad wireframe curves. Dem
Unterknoten Bad wireframe curves und dessen Elementen sind rote
Punkte vorangestellt, die anzeigen, dass es sich bei dem Defekt um einen
Fehler handelt. Der Problembereich des Modells wird vergrof3ert und der
Defekt wird griin hervorgehoben.
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Hinweis

Fehlerhafte Drahtgitterkurven sind das Ergebnis mangelhaft definierter Spalte.
Spalte wirken sich auf die Umwandlung des Modells in einen Volumenkorper
aus. Sie miissen fehlerhafte Drahtgitterkurven reparieren, wenn anhand des
Modells gefertigt werden soll; wenn das Modell zum Konvertieren in einen
Volumenkérper dient, sind jedoch keine Reparaturmal3nahmen erforderlich. Sie
kénnen Spalte erst schlieBen, nachdem fehlerhafte Drahtgitterkurven repariert
oder entfernt wurden.

Im Textbereich von Fehlerbeheber (Troubleshooter) werden folgende Aktionen
empfohlen:

* Verwenden Sie das Tool "Aus Drahtgitter entfernen" (Remove from
Wireframe), um den betreffenden Spalt aus dem Drahtgitter zu entfernen
und die entsprechende zweiseitige Kante in zwei einseitige Kanten zu
konvertieren.

* Verwenden Sie das Tool "Kurve/Drahtgitter zusammenfiihren" (Merge
Curve/Wireframe), um benachbarte einseitige Kanten der gleichen Flache
zu einzelnen einseitigen Kanten zu kombinieren.

* Definieren Sie mit dem Such-Tool oder dem Tool "Spalte definieren”
(Define Gap) einen Spalt.

* Fiigen Sie den Spalt dem Drahtgitter mit dem Tool "Zu Drahtmodell
hinzufiigen" (Add to Wireframe) hinzu.

» Korrigieren Sie den Spalt mit den Spaltreparatur-Tools ("Reparieren"
(Repair), "SchlieBen" (Close), "Angleichen" (Match) usw.

3. Waihlen Sie das rot hervorgehobene Drahtgitter aus, klicken Sie mit der rechten

Maustaste, und klicken Sie im Kontextmenii auf Aus Drahtmodell entfernen
(Remove from Wireframe), oder wihlen Sie auf der Registerkarte Bedingung

definieren (Constrain) die Befehlsfolge . Drahtgitter (Wireframe) » . Aus
Drahtgitter entfernen (Remove from Wireframe), entsprechend der IDD-

Empfehlung im Textbereich von Fehlerbeheber (Troubleshooter).

Mit dem Angleichen-Tool nicht erfullte Drahtgitter reparieren

Das Angleichen-Tool repariert Problemflachen und nicht erfiillte topologische
Verbindungen von Fldchen. Es korrigiert auch die zugehorigen
Tangentialitidtsbedingungen.

Das Angleichen-Tool verdndert Flichen, unabhédngig davon, ob sie eingefroren
sind. Es taut Flichen vor der Reparatur auf, insbesondere Flachen, die eingefroren
wurden, weil sie analytische Flachen oder Flichen hoherer Ordnung sind, mit mehr
als vier Seiten getrimmt oder expliziert eingefroren wurden. Das Angleichen-Tool
kann Flachen mit mehr als vier Seiten reparieren, weil es den eingefrorenen Status
ignoriert und sie vor der Reparatur nicht in vierseitige Einzelflachen konvertiert.
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Sie miissen die giiltige Geometrie, z.B. eine Gruppe von Flachen oder
Drahtgitterkurven der aktiven Komponente oder der aktiven Gruppe von Flachen
auswéhlen, bevor Sie das Angleichen-Tool aufrufen.

1. Aktivieren Sie component 251.

2. Waihlen Sie ein Element im Unterknoten Unsatisfied Wireframe aus.
Dem Unterkoten Unsatisfied Wireframe und seinen Elementen sind
blaue Punkte vorangestellt, die anzeigen, dass dieser Defekt informativer Art
ist. Der Problembereich des Modells wird vergrofert und das Drahtgitter wird
griin hervorgehoben.

3. Waihlen Sie das Drahtgitter aus, das im Modell griin hervorgehoben ist.

4. Waibhlen Sie die Befehlsfolge Heilen (Heal) » Angleichen (Match). Das
Dialogfenster Eingefrorene Flachen angleichen (Match Frozen Surfaces) wird
geoOftnet.

5. Kilicken Sie im Dialogfenster Eingefrorene Flachen angleichen (Match Frozen
Surfaces) auf Ja (Yes). Die Registerkarte Angleichen (Match) wird gedftnet. Im
Modell werden standardméaBig die neuen Flidchen, deren Drahtgitter und
Tangentialitdt dargestellt.

6. Klicken Sie auf die Registerkarte Optionen (Options), und wihlen Sie eine
Option, um die Flichenanzeige zu dndern, so dass die neuen und die
urspriinglichen Fldchen oder nur die neuen Flachen angezeigt werden.

7. Aktivieren Sie das Kontrollkdstchen Tangentialitét reparieren (Repair
Tangency).

8. Klicken Sie auf .

Mit dem Reparatur-Tool nicht erfullte Tangentialitat
reparieren

1. Erweitern Sie den Unterknoten Unsatisfied tangency, und wahlen Sie
Item 1 aus. Die fehlerhafte Geometrie wird griin hervorgehoben.

2. Kilicken Sie im Fehlerbeheber (Troubleshooter) mit der rechten Maustaste auf

das ausgewdhlte Element, und wihlen Sie im Kontextmenii den Befehl
Problemgeometrie wahlen. Die mangelhafte Geometrie in Griin wird im

Modell ausgewahlt.

3. Klicken Sie im Modell mit der rechten Maustaste auf die gewéhlte Geometrie,

und wihlen Sie im Kontextmenii den Befehl Elternflichen wahlen (Select
parent surfaces). Fiir Ttem 1, surface 87 und surface 226 von

component 251 wird die Auswahl im GTS-Baum dargestellt.

4. Klicken Sie mit der rechten Maustaste, und wihlen Sie im Kontextmenii die
Option Aktivieren (Activate). Die Aktivierung von Surface 87 und
surface 226 wird im GTS-Baum dargestellt.

5. Waihlen Sie die Befehlsfolge Heilen (Heal) » @ Reparieren (Repair). Die
Registerkarte Reparieren (Repair) wird geoffnet.

™
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6. Aktivieren Sie das Kontrollkdstchen Tangentialitat reparieren (Repair
Tangency).

7. Klicken Sie auf .
Hinweis
Geometrische Defekte informativer Art, z.B. nicht erfiillte Drahtgitter oder

Tangentialitit, denen im Fehlerbeheber-Baum blaue Punkte voranstehen, kénnen
im Modell bleiben, ohne behoben zu werden.

Fehlende Flachen hinzufugen

Nachdem die Spalte geschlossen sind, miissen Sie fehlende Flachen hinzufligen.
Erzeugen Sie mit dem Berandungsverbund-Tool eine Berandungsverbundflache
zwischen Referenzelementen. Mit diesem Tool wird die Fliche in einer oder in
zwel Richtungen definiert. Das erste und das letzte gewéhlte Element in jeder
Richtung definieren die Berandung der Fliche. Verwenden Sie die folgenden
Abbildungen als Referenz.

1 Fehlende Fldche

1. Waihlen Sie die Befehlsfolge Erzeugen (Create) » @ Berandungsverbund
(Boundary Blend). Die Registerkarte Berandungsverbund (Boundary Blend)

wird gedffnet. Klicken Sie auf die Registerkarte Kurven (Curves). Der
Kollektor Erste Richtung (First direction) ist aktiv.

2. Wihlen Sie die Kurven A und B fiir die erste Flachenrichtung aus.

3. Klicken Sie auf den Kollektor Zweite Richtung (Second direction), und wihlen
Sie im Arbeitsfenster die Kurven C und D aus.

4. Klicken Sie auf . Die Flache wird erzeugt.
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1 Kurven Erste Richtung
2 Kurven Zweite Richtung

Flachen vereinen

Die letzte Aufgabe besteht darin, die soeben erzeugte neue Flache mit dem Rest
des Import-KE zu vereinen. Mit Hilfe des Vereinen-Tools verbinden Sie die neue
Berandungsverbundflidche mit der Komponente, die die Sammelfliche enthilt.

1. Waihlen Sie das importierte KE im GTS-Baum aus, halten Sie die
UMSCHALTTASTE oder STRG gedriickt, und wéhlen Sie die Fliache aus.

W Import Featura id 5
(i [Burface 263

v g Component 251
(=1 Surface 0

[~ Surface 21

[ Surface 27

[~ Surface 31

[ Surface 37

[~ Surface 43

2. Wihlen Sie die Befehlsfolge Struktur (Structure) » I:I Kombinieren (Combine),
oder klicken Sie mit der rechten Maustaste, und wahlen Sie im Kontextmenii
den Befehl Kombinieren (Combine). Die kombinierte Flache wird im GTS-
Baum angezeigt (siche Abbildung):

[ Import Feature id 5

» 'J Combine 272

v g Component 251
Surface 0
Surface 21
Surface 27
Surface 31
Surface 37
Surface 43

™
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Die Flache und die Komponente werden im GTS-Baum als Kombinationsknoten
angezeigt.

Sie konnen die neue Fliche auch wie folgt auf den Komponentenknoten ziehen:

1. Klicken Sie auf Widerrufen (Undo) 3. Die letzte Operation (Kombinieren
(Combine)) wird riickgdngig gemacht.

2. Klicken Sie im GTS-Baum auf das Flachensymbol, und ziehen Sie es auf das
Komponentensymbol (halten Sie dabei die linke Maustaste gedriickt, bis die
Komponente automatisch erweitert wird, bevor Sie die Taste wieder loslassen).
Die Fléche ist jetzt ein Mitglied der Komponente und ist mit dem Rest der
Sammelflache verbunden.

[ Import Feature id 5
v £ Component 251

(=l Surface 0
(A Surface 21
(<] Surface 27
(2] Surface 31
[~ Surface 37
(2 Surface 43

Hinweis

Sie konnen den vereinten Knoten verkleinern, um das gleiche Ergebnis wie mit
einer Ziehen- und Ablegen-Operation zu erzielen, ohne die Vereinen-Aufgabe
riickgédngig zu machen.

Das Attribut "Volumenkorper® fur das
Import-KE festlegen

Obwohl Sie die Berandungsverbundfldche mit den anderen Fldchen vereint haben,
handelt es sich bei dem Modell um eine Sammelflache, die in ein Volumenkorper-
Import-KE konvertiert werden muss.

1. Klicken Sie auf der Multifunktionsleisten-Registerkarte Import DataDoctor

(Import DataDoctor) auf , um IDD zu beenden und wieder die Registerkarte
Importieren (Import) aufzurufen.

2. Waibhlen Sie E auf der Registerkarte Importieren (Import). Das importierte
Modell ist jetzt ein Creo Parametric Volumenkorper-KE.

3. Waihlen Sie auf der Registerkarte Importieren (Import).

Speichern Sie das Modell im Arbeitsverzeichnis.
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Zusammenfassung

Dies sind einige der grundlegenden Tools und Operationen, die in Import
DataDoctor zum Reparieren importierter Modell verwendet werden. Weitere
Informationen finden Sie im Creo Parametric 1.0 Ressourcencenter, das im Creo
Parametric Hilfe-Center verfiigbar ist.

Hinweis
Wenn Sie mit Associative Topology Bus (ATB) die importierte Geometrie

aktualisieren, miissen Sie die Geometrie erneut reparieren, wenn die gleichen
Fehler in der aktualisierten Geometrie weiterhin auftreten.

™
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Verwenden erweiterter
Reparaturtechniken

SeitenflAChen rePANEIEN .........uui et eeeees 46
Fehlende FIAchen ersetzen ... ... e 48
ZUSAMMENTASSUNG ...ttt ettt ettt e et ettt e e et e et e e e e e aaa e e e e e e aaa e e e eeenaans 52

Im vorhergehenden Kapitel haben Sie einige grundlegende Reparatur-Tools von
Import DataDoctor (IDD) kennen gelernt. In diesem Kapitel lernen Sie weitere
Moglichkeiten zum Reparieren von Modellen kennen. Hierzu gehoren der Ersatz
der Trimkanten einer Flichenberandung sowie das Kopieren und Einfligen einer
Flache an einer neuen Position.

Importieren Sie zuerst erneut die STEP-Datei (basic_probs w_slvr.stp)
aus Kapitel 2. Klicken Sie nun im Modellbaum mit der rechten Maustaste auf das

Import-KE, und wéhlen Sie im Kontextmenii den Befehl Definition editieren (Edit
Definition). Definition editieren (Edit Definition) ist auch im Menii Modell (Model) >
Operationen (Operations) verfiigbar.

Klicken Sie auf der Registerkarte Importieren (Import) auf , um die
Registerkarte Import DataDoctor (Import DataDoctor) zu 6ffnen und die IDD-
Umgebung aufzurufen. Entfernen Sie die doppelten Flichen, wie in Kapitel 2 im
Verfahren "Zusammenfallende Flachen entfernen" erldutert. Jetzt konnen Sie die
Seitenfldche des importierten Modells reparieren.
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Seitenflachen reparieren

In dieser Ubung lernen Sie, wie eine neue UV-Kurve durch Punkte erzeugt wird,
die auf einer ausgewéhlten Fliache im importierten Modell liegen. Mit Hilfe dieser
neuen Kurve ersetzen Sie die vorhandene Trimkante an der Berandung der unten
hervorgehobenen Fliche.

1. Wihlen Sie die Seitenfldche im Arbeitsfenster aus.
2. Wihlen Sie die Befehlsfolge Erzeugen (Create) » UV-Kurven (UV-Curves)

> @ UV-Kurve durch Punkte (UV-Curve through Points). Die Registerkarte
UV-Kurve durch Punkte (UV-Curve through Points) wird geodftnet.

3. Wihlen Sie die Eckpunkte A und B aus.
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4.

Hinweis
Halten Sie die STRG-Taste gedriickt, um beide Eckpunkte gleichzeitig
auszuwdhlen.

Klicken Sie auf der Registerkarte UV-Kurve durch Punkte (UV-Curve through
Points) auf . Die UV-Flachenkurve wird erzeugt und blau hervorgehoben.

Berandungskanten ersetzen

Jetzt ersetzen Sie die Berandungskante der im vorherigen Abschnitt ausgewahlten
Flache durch die soeben erzeugte Kurve. Danach schlie8en Sie die Spalte mit Hilfe
des Such-Tools.

I.

Wihlen Sie im Arbeitsfenster die vorhandene Berandungskante aus (die leicht
gebogene Kante direkt unter der zuvor erzeugten neuen Kurve). Die
ausgewihlte Kante wird im Modell wie unten gezeigt rot dargestellt.

Waihlen Sie die Befehlsfolge Editieren (Edit) » Ersetzen (Replace). Die

Registerkarte Ersetzen (Replace) wird gedffnet, und der Kollektor Ersetzen
durch (Replace with) ist aktiv.

Wihlen Sie im Arbeitsfenster die neu erzeugte UV-Kurve aus. Die Kurve wird
im Kollektor Ersetzen durch (Replace with) angezeigt.

Klicken Sie auf der Registerkarte Ersetzen (Replace) auf . Die gebogene
Flachenkante wird durch die neue Kurve ersetzt.

Verwenden Sie nun die in Kapitel 2 erlernten Techniken, um die librigen Spalte
in der Sammelflache zu definieren und zu reparieren.
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Fehlende Flachen ersetzen

Im vorherigen Kapitel haben Sie mit dem Berandungsverbundfldchen-Tool eine
fehlende Fldche hinzugefiigt. Jetzt lernen Sie eine weitere Moglichkeit zum
Reparieren des importierten Modells kennen, wobei Sie mit den Tools "Kopieren"
(Copy) and "Spezial einfligen" (Paste Special) die durch die fehlende Flache
gelassene Bohrung fiillen. Sie kopieren eine vorhandene Flache und fligen die
kopierte Fliche mithilfe der Registerkarte Transformieren (Transform) hinzu. Zum
Schluss richten Sie die neue Fliche aus. Verwenden Sie die folgenden
Abbildungen als Referenz.

% |
i \

1 Fehlende Fldche

/

|

1 Zu kopierende Flache

1. Waihlen Sie surface 49 im GTS-Baum aus, klicken Sie mit der rechten
Maustaste, und wihlen Sie im Kontextmenii den Befehl Kopieren (Copy).

2. Klicken Sie mit der rechten Maustaste, und wéhlen Sie im Kontextmenii den
Befehl Spezial einfiigen (Paste Special). Die kopierte Flache wird an der
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gleichen Stelle in das Modell eingefligt wie im Original, und die Registerkarte
Transformieren (Transform) wird gedffnet. Die Registerkarte Verschieben
(Move) und der 3D-Ziehgriff sind aktiviert (siche Abbildung).

3. Wihlen Sie den Pfeil an der x-Achse des 3D-Ziehgriffs aus und transformieren
Sie ihn nahe dem leeren Bereich, um die eingefiigte Fliche im Arbeitsfenster
neu zu positionieren.

1 Eingefiigte Flache

4. Klicken Sie auf das sphérische Handle, um die kopierte Flidche zu rotieren und
die eingefiigte Flache in Richtung des orangefarbenen Pfeils zu rotieren.
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5. Klicken Sie auf die Registerkarte Platzierung (Placement), und legen Sie den
Typ fiir Beziehung (Relationship) auf Zusammenfallend (Coincident) fest.

6. Klicken Sie auf den Kollektor Komponentenelement auswahlen (Select
component item), und wéhlen Sie Eckpunkt A1 (Vertex A1) aus.

7. Klicken Sie auf den Kollektor Baugruppenelement auswihlen (Select
assembly item), und wihlen Sie Eckpunkt A2 (Vertex A2) aus. Eckpunkt A1

und Eckpunkt A2 werden ausgerichtet.

A1

™
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8. Klicken Sie auf Neue Bedingung (New Constraint), und legen Sie den Typ fiir
Beziehung (Relationship) auf Automatisch (Automatic) fest.

9. Klicken Sie auf den Kollektor Komponentenelement auswihlen (Select
component item), und wéhlen Sie Eckpunkt B1 (Vertex B1) aus.

10. Klicken Sie auf den Kollektor Baugruppenelement auswahlen (Select
assembly item), und wiéhlen Sie Eckpunkt B2 (Vertex B2) aus. Eckpunkt B1

und B2 Eckpunkt sind nun orientiert, und die Flache ist vollstindig definiert.

1 Zusammenfallend (Coincident)
2 Orientiert (Oriented)

11. Klicken Sie auf der Registerkarte Transformieren (Transform) auf . Die
Flache wird ersetzt.

12. Verwenden Sie zum Schluss wie in Kapitel 2 das Vereinen-Tool, um die Flache
mit der Sammelflichenkomponente zu vereinen, oder ziehen Sie die neue
Flache in die Komponente. Auf der Fliche werden keine Spalte angezeigt.
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13. Deaktivieren Sie die aktiven Komponenten, um den IDD-Modus zu beenden.

UV-Kurven ausblenden und loschen

UV-Kurven konnen nicht unabhéngig von den Flachen, auf denen sie definiert
sind, ausgeblendet werden, da UV-Kurven im GTS-Baum nicht durch Knoten
dargestellt werden. Sie werden ausgeblendet, wenn die Flachen, auf denen sie
definiert wurden, ausgeblendet werden.

UV-Kurven kénnen jedoch geldscht werden. Wenn Sie eine UV-Kurve als Ersatz
fiir eine Kante verwenden, wird die UV-Kurve an der Berandung der Flache
ausgerichtet und der Flidche zugeordnet. Es besteht keine Assoziativitit zwischen
der UV-Kurve und der Kante. Daher konnen Sie die UV-Kurve nach der Ersetzung
16schen, wenn sie nicht mehr bendtigt wird.

Sie konnen den Auswahlfilter auf UV-Kurven einstellen und einen
Berandungsquader tiber das Modell ziehen, um alle UV-Kurven im Modell
gemeinsam auswéhlen.

Zusammenfassung

In dieser Ubung haben Sie die Kante einer Fliche durch eine Kurve ersetzt.
AuBerdem haben Sie gelernt, wie Spalte mit den Tools "Kopieren" (Copy) and
"Spezial einfliigen" (Paste Special) geschlossen werden. In den folgenden Kapiteln
lernen Sie weitere Werkzeuge kennen.

™
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Andern der oberen Flache des
Modells

Obere FIACheN QuUSIIChIEN .........iii e 54
Eckpunkt bewegen und das Modell angleichen ..o 57
Ubrige Spalte definiereN..............ocve it 59

Im vorherigen Kapitel haben Sie gelernt, wie ein Modell mit Hilfe von
Anderungen der Flichenberandung repariert wird und wie die Kopieren- und
Spezial einfiigen-Tools verwendet werden. Jetzt erfahren Sie, wie eine grof3ere
Flache geéndert und wie sie als Teil der Sammelfldche in die Volumenkomponente
eingefligt wird.

Offnen Sie zuerst big gap.igs. Orientieren Sie sie im Arbeitsfenster so, dass
die obere Fliache nach oben weist, klicken Sie im Modellbaum mit der rechten

Maustaste darauf, und wihlen Sie im Kontextmenii den Befehl Definition editieren
(Edit Definition).

Klicken Sie auf der Registerkarte Importieren (Import) auf , um die
Registerkarte Import DataDoctor (Import DataDoctor) zu 6ffnen und die IDD-
Umgebung aufzurufen. Jetzt konnen Sie die obere Flidche des importierten Modells
andern.
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Obere Flachen ausrichten

In dieser Ubung lernen Sie, wie Trimberandungskanten geldscht werden, und
richten die Fldche anschliefend aus und dndern sie, damit sie sich der
Sammelfliche des Modells anpasst. Verwenden Sie die folgenden Abbildungen als
Referenz.

1. Wahlen Sie Surface 43 im GTS-Baum aus.

2. Waihlen Sie die rechte Kante der Flache aus, klicken Sie mit der rechte
Maustaste, und wihlen Sie im Kontextmenii den Befehl Léschen (Delete), oder
driicken Sie die Delete-Taste.

Hinweis

Da eine Trimkante nicht unvollstindig oder offen sein darf, werden beim

Loschen einer Trimkante auch alle anderen Trimkanten gel6scht, die eine
geschlossene Schleife fiir diese Fldche bilden. Wenn eine Fléiche z.B. eine
interne Bohrung aufweist und Sie eine Kante dieser internen Schleite von

Trimmkanten auswéihlen und l6schen, wird die Bohrung aus der Flache
entfernt.
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3. Waihlen Sie nun die Fliche aus, und wihlen Sie die Befehlsfolge Editieren

(Edit) » k| Ausrichten (Align). Die Registerkarte Ausrichten (Align) wird
geoffnet. Die untere Kante wird hervorgehoben. Dies ist die auszurichtende
Flachenkante.

4. Waihlen Sie die entsprechende Berandungskante der angrenzenden
Sammelflachenberandung aus. Die Fldchenkante wird an der
Sammelflachenkante ausgerichtet.
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5. Kilicken Sie auf das Handle und ziehen Sie die Kante, bis sie genauso lang wie
die entsprechende Kurve auf der Sammelflache ist.

6. Klicken Sie auf die Registerkarte Flachenseiten (Surface Sides). Die vordere
Kante und die vordere Kurve werden als Side 1 angezeigt. Das Bedingungs-
Tool Tangential (Tangent) ist aktiv.

7. Klicken Sie in den Kollektor "Seite 3" (Side 3), um die rechte Kante der Flache
vorab auszuwihlen. Die Tangentialbedingung ist auch fiir diese Kante aktiv.
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8. Waihlen Sie die rechte Kurve als Seite 3 aus. Die Flachenkante wird an der
Sammelflichenkante ausgerichtet. Verwenden Sie die Handles, um den Start-
und Endpunkt der ausgerichteten Kante anzupassen.

9. Klicken Sie auf der Registerkarte Ausrichten (Align) auf . Die beiden
Kanten werden mit dem Modell zusammengefiihrt.

Hinweis
Nur zwei der vier Kanten der Fliche sind ausgerichtet. Die Kanten 2 und 4
kénnen nicht ausgerichtet werden, da Tangentialbedingungen aktiv sind. Wenn

Sie die Randbedingungen fiir die Seiten 1 und 3 auf "Position" dndern, konnen
Sie die Seiten 2 und 4 ausrichten (ebenfalls aut "Position" festgelegt).

Eckpunkt bewegen und das Modell
angleichen

Jetzt andern Sie die anderen Seiten der Flache, die Sie im vorherigen Abschnitt mit
dem Modell ausgewihlt haben.

1. Aktivieren Sie die Drahtgitteransicht, und wihlen Sie die Flache aus.

2. Wihlen Sie die Befehlsfolge Editieren (Edit) > @ Eckpunkt bewegen (Move
Vertex).

3. Wihlen Sie den Schnittpunkt der beiden verbleibenden Seiten aus. Klicken und
ziehen Sie den Punkt, bis er dem entsprechenden Punkt im Modell nahe ist. Sie
miissen das Modell eventuell verschieben oder rotieren, um besser darauf
zugreifen zu konnen.

Andern der oberen Fliche des Modells 57



i

4. Klicken Sie auf OK (OK), um das Tool zu beenden.

Das Tool Eckpunkt bewegen (Move Vertex) bleibt aktiv, bis Sie auf OK (OK) oder
Abbrechen (Cancel) klicken. Es ist eine Aktion-Objekt-Option, die es Thnen

erlaubt, jeden Eckpunkt im Modell auszuwiahlen und zu verschieben, nachdem Sie
ihn aktiviert haben.

Wenn Sie einen Eckpunkt an eine andere Position ziehen, wird der Eckpunkt
verschoben und an dieser Position eingerastet. Der eingerastete Eckpunkt wird zur
néchsten Projektion des Zieleckpunkts auf der gedinderten Flache verschoben.

Sie konnen Eckpunkte auch dann verschieben, wenn die relevanten Flachen
eingefroren sind oder Tangentialbedingungen vorliegen. Eckpunkte von
zweiseitigen Kanten kdnnen nicht verschoben werden.

™
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Nach dem Verschieben des Eckpunkts die Flache
abtrennen und hinzufugen

Wenn Sie einen Eckpunkt verschieben, werden automatisch aus den zugehorigen
einseitigen Kanten und den angrenzenden einseitigen Kanten benachbarter Flachen
zweiseitige Kanten erzeugt (sofern mdglich). Dies geschieht bei jeder einzelnen
Verschiebung; zweiseitige Kanten werden selbst dann dynamisch erzeugt, wenn
Sie das Tool "Eckpunkt bewegen" (Move Vertex) verlassen.

AuBerdem konnen Sie keinen Eckpunkt verschieben, der zu einer Kante mit einer
zugeordneten und erfiillten topologischen Randbedingung gehort. Obwohl die
topologischen Bedingungen im Anderungsmodus nicht angezeigt werden konnen,
ist diese Beschrinkung sichtbar, wenn der verschobene Eckpunkt einrastet, um das
Schlieflen einer Berandung zu bewirken. Sie konnen einen Eckpunkt erst dann
ziehen und verschieben, wenn Sie die topologische Randbedingung entfernen.

Beide Probleme konnen Sie dadurch beheben, dass Sie die Flache vor dem Einsatz
des Tools "Eckpunkt verschieben" (Move Vertex) abtrennen. Sie konnen den
Eckpunkt dann unbeschrinkt durch Ziehen und Ablegen verschieben, um ihn
optimal zu platzieren, bevor IDD versucht, neue zweiseitige Kanten zu erzeugen.
Die abgetrennte Flache wird in den obersten Knoten des GTS-Baums verschoben.
Nachdem Sie die endgiiltige Position des Eckpunkts festgelegt haben, schneiden
Sie die Flache aus und fiigen sie in die urspriingliche Komponente des GTS-
Baums ein.

Ubrige Spalte definieren

Sie sehen, dass Sie die beiden letzten Kanten nahe der Sammelfldchenberandung
platziert haben, dass jedoch noch einige Spalte geblieben sind. Reparieren Sie
diese Spalte auf dieselbe Weise wie zuvor.

1

1 Spalt 1
2 Spalt2
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Waihlen Sie die neue Flache aus, und wihlen Sie die Befehlsfolge Heilen (Heal)

> Angleichen (Match). Mit diesem Tool werden die Kanten der Flache den
urspriinglichen Flidchen angeglichen.

1.

2. Deaktivieren Sie die Komponente im Modellbaum, und beenden Sie IDD. Das
Modell ist jetzt repariert.
Hinweis
Wenn die Komponente nicht explizit oder implizit aktiv ist, ist die Option L
Zu Drahtmodell hinzufiigen (Add to Wireframe) nicht verfiigbar, und Sie kénnen

die Spalte dem Drahtgitter nicht hinzufiigen. Sie miissen die Komponente
explizit aktivieren, wenn mehrere Basisknoten vorhanden sind, bzw. implizit
aktivieren, wenn nur eine einzige Komponente aut der Basisebene vorhanden

ist.
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Konvertieren von Flachen in Zylin-
der und Profilkorper
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Flachen in ein Profil-KE Konvertieren..............ooo i 65
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Im vorherigen Kapitel haben Sie gelernt, wie ein Modell mit Hilfe von
Flachendnderungen repariert wird. In diesem Kapitel erfahren Sie, wie Pseudo-KEs
im importierten Modell erzeugt werden. Diese Pseudo-KEs konnen bei Bedarf
spater gedndert werden. Sie lernen Folgendes:

* Eine fehlende Fliche mit dem Berandungsverbund-Tool hinzufiigen

* Flachen auswéhlen und in ein Zylinder-KE konvertieren, wobei der
Durchmesser des Elements gedndert wird

» Kermn- und Berandungsflachensitze auswéhlen, um ein Profil-KE zu erzeugen,
und den Profil-Knoten anschlieend mit dem Befehl "Transformieren"
(Transform) bewegen

* Mit dem Entfernen-Tool nicht mehr bendtigte Geometrieflachen entfernen

Beginnen Sie folgendermallen:

1. Offnen Sie die Datei d_step214 shtmtlpartlow.stp, und speichern
Sie sie im Arbeitsverzeichnis.

2. Laden Sie das Modell, wihlen Sie das Import-KE im Modellbaum aus, klicken

Sie mit der rechten Maustaste, und wahlen Sie im Kontextmenii den Befehl
Definition editieren (Edit Definition).

3. Klicken Sie auf der Registerkarte Importieren (Import) auf , um die
Multifunktionsleisten-Registerkarte Import DataDoctor (Import DataDoctor) zu
offnen und die IDD-Umgebung aufzurufen.
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Fehlende Flachen hinzufugen

Auch dieses Mal fiigen Sie mit dem Berandungsverbund-Tool eine fehlende Flache
hinzu und schlieBen die gesamte Sammelflache.

1. Wihlen Sie edge A und edge B wie in der folgenden Abbildung dargestellt
aus:

. %
2. Wihlen Sie die Befehlsfolge Erzeugen (Create) » Berandungsverbund
(Boundary Blend). Die Registerkarte Berandungsverbund (Boundary Blend)

wird gedffnet. Die ausgewahlten Kanten befinden sich im Ketten-Kollektor 1.
Richtung.

3. Klicken Sie im zweiten Kollektor, und wihlen Sie die iibrigen beiden Kanten
der fehlenden Fliche aus.
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4. Klicken Sie auf der Registerkarte Berandungsverbund (Boundary Blend) auf

. Die Berandungsverbundflache wird erzeugt, und die fehlende Flache wird
hinzugefiigt. Im GTS-Baum wird eine neue Flache (surface 661) angezeigt.

."Q[\ ~ (O ImportFeatureid 5
- T l - . (A Surface 661
* T— - v £ Component 660
(=1 Surface 0

(<1 Surface 17
X ) . (- Surface 25
\ N\ -jf (<1 Surface 29
f — _ (7 Surface 37
J ~— ) " f_ (4 Surface 41
J g (=1 Surface 47
H . ’# ’_, - L::l Surface 40
) | 7 (11 Surface 55
' (=1 Surface 57

5. Waihlen Sie die neue Flaiche im GTS-Baum aus, und zichen Sie sie {iber den
Komponentenknoten im Baum. Bewegen Sie den Cursor iiber den Knoten, bis
dieser erweitert wird, und legen Sie die Flache in der Komponente ab.

(3 Import Feature id 5
-~ N~ v £ Component 660
LN ~_ (A Surface 661
N\ (4 Surface 0
- (2 Surface 17
A\ P (A Surface 25
A\ i'::.'—”" ) (= Surface 29
A\ K_H'“_“' ) ] (4 Surface 37
|'| T (A Surface 41
(3 Surface 47
~J L (4 Surface 49
““""" (A Surface 55

Konvertieren von Flachen in Zylinder und Profilkérper 63




Hinweis

Alle Flachen in einer Komponente sind logisch verkniipft und werden
automatisch miteinander verbunden, falls dies moéglich ist. Verwenden Sie
andernfalls die in den Kapiteln 1 und 2 erlernten Techniken, um eventuelle
Spalte zu schlieBen.

Flachen in ein Zylinder-Pseudo-KE
konvertieren

Jetzt konvertieren Sie die Flachen einer Bohrung in ein Zylinder-Pseudo-KE.
Verwenden Sie die Abbildung unten als Referenz.

1. Aktivieren Sie die Komponente im Modellbaum.

2. Waihlen Sie surface 353 und surface 356.

O

3. Waihlen Sie auf der Registerkarte Struktur (Structure) die Befehlsfolge

Konvertieren (Convert) » In Zylinder konvertieren (Convert to Cylinder). Die
Registerkarte In Zylinder konvertieren (Convert to Cylinder) wird geoffnet.

4. Stellen Sie den Radius auf 3.50 ein.
5. Klicken Sie auf der Registerkarte In Zylinder konvertieren (Convert to Cylinder)

auf . Das Zylinder-Pseudo-KE wird erzeugt. Das neue Pseudo-KE wird im
GTS-Baum als Cylinder-KE, Teil des Combine-Knotens angezeigt. Die
restlichen Flichen werden unter Component 660 gruppiert.

[ KE-ID 5 importieren

v CE 633 kombinieren

[ :ﬂ Komponente B0
=) Zylinder 652

™
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Hinweis
Sie kénnen den Radius des Zylinder-Pseudo-KE dndern, nachdem Sie es
erzeugt haben. Wiéhlen Sie den Zylinder-Knoten im GTS-Baum aus, klicken

Sie mit der rechten Maustaste, und klicken Sie im Kontextmenii auf Andern
(Modify), um die Registerkarte In Zylinder konvertieren (Convert to Cylinder)

aufzurufen.

Flachen in ein Profil-KE konvertieren

Jetzt erzeugen Sie ein Profil-KE aus einem ausgewéhlten Flachensatz.
Verwenden Sie die folgende Abbildung als Referenz.
1. Wihlen Sie die Flachen 1, 2, 3, 4 und 5 aus.

2. Wenn alle Flichen ausgewéhlt wurden, wéhlen Sie auf der Registerkarte

Struktur (Structure) die Befehlsfolge Konvertieren (Convert) > @ In Profil-
KE konvertieren (Convert to Extrude). Die Registerkarte In Profil-KE
konvertieren (Convert to Extrude) wird gedftnet.

3. Klicken Sie auf der Registerkarte In Profil-KE konvertieren (Convert to Extrude)
auf . Das Profil-Pseudo-KE wird erzeugt.

* Das neue Pseudo-KE wird im GTS-Baum als Kombinationsknoten
angezeigt.

* Das neue KE wird als Profil-KE angezeigt und ist im GTS-Baum Teil des
Combine 693-Knotens.

J Import Feature id 5
v (& Combine 683
¢ 25 Component 660
=) Cylinder 682
g1 Extrude 717

Profil-Knoten transformieren

Jetzt transformieren Sie die Position des Profil-KE. Dazu erzeugen Sie einen neuen
Bezugsknoten als permanente Referenz fiir die Transformation.
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1.

2.
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Waihlen Sie die vertikale planare Seitenfliche des Profil-Pseudo-KE aus, und
wihlen Sie anschliefend in der Symbolleiste das Bezugsebenen-Tool aus.

Ziehen Sie die Bezugsebene parallel zur Seitenfliche des Profil-Pseudo-KE.

.\

Klicken Sie auf OK. Das Dialogfenster Bezugsebene (Datum Plane) wird
geschlossen.

Wihlen Sie den Profil-Knoten im GTS-Baum aus, klicken Sie mit der rechten

Maustaste, und wihlen Sie im Kontextmenii den Befehl Transformieren
(Transform). Die Registerkarte Transformieren (Transform) wird geoffnet.

. Wihlen Sie die Bezugsebene als Bewegungsreferenz (Motion Reference) aus.

StandardmédBig wird die Richtung auf Normal (Normal) festgelegt.

Hinweis

Sie konnen einen Knoten entweder an eine andere ungefdhre Position ziehen
oder Objekte mit Hilfe der Randbedingung "Gegenrichten" (Mate) oder

"Ausrichten" (Align) in Bezug autf andere Objekte platzieren. Mit der zweiten
Methode wird die Komponente prézise verschoben.

Wihlen Sie die vertikale Seitenfldche des Profil-Pseudo-KE aus, und wahlen
Sie anschlieend die Seitenfliche der Bezugsebene aus. Das Profil-Pseudo-KE
muss an der Bezugsreferenz einrasten.

™
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7. Klicken Sie auf der Registerkarte auf . Das Profil-Pseudo-KE und die
angrenzenden Flachen werden aktualisiert und miteinander verbunden.

Ist Vereinen dasselbe wie Geometrie verkleinern
und zusammenfuhren?

Mit der Option "Verkleinern" (Collapse) wird ein komplexer Knoten in einen
einzelnen Komponentenknoten verwandelt (siche Abbildung).

(1 KE-ID' 4 impoartieren

ﬂ Komponente 251

¥ Ausschlisfian

Die Verbindungen werden beibehalten, die gesamte Struktur wird jedoch entfernt.
Das heif3t, es werden keine neuen Verbindungen erzeugt, wiahrend die Struktur
vereinfacht wird. Die Option "Verkleinern" (Collapse) in IDD ist nicht identisch
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mit der Option "Verkleinern" (Collapse) in Creo Parametric, mit der Sie einem aus
nachgeschalteten Creo Parametric Flichen-KEs importierten KE Geometrie
hinzufligen konnen.

Die Geometrie wird mit der Option "Kombinieren" (Combine) nicht verandert,
wenn der Kombinationsknoten wie unten gezeigt erzeugt wird.

[ KE-ID' 4 importieren
= d:;! 253 kombinieren
:ﬁ) Komponente 251
Flache 0
¥ AusschiieBen

Mit der Option "Vereinen" (Combine) werden nur die Berandungen
zusammengefligt, die geometrisch libereinstimmen. Aufgaben, wie das Anfligen
einer Komponente wéhrend der Konvertierung von Flachen in Ebenen, Zylinder,
gedrehte oder Profil-KEs oder das Unterteilen einer Komponente, erzeugen
automatisch vereinte Verbindungen. Wenn Elemente mit der Option "Vereinen"
(Combine) direkt gruppiert werden, werden nur dann Verbindungen eingerichtet,
wenn die Berandungen der Sammelflidchen, die vereint werden, bereits innerhalb
der Toleranzgrenzwerte libereinstimmen.

= 63 kornbinieren
:ﬂ Komponente 251
=3 Zylinder 267
¥ Ausschlisfien

Ein Kombinationsknoten éndert die Berandungen seiner Sammelfldchenelemente,
um die Verbindungen aufrechtzuerhalten, die zwischen ihnen eingerichtet wurden.
Er erweitert oder schneidet die Berandungen der vereinten Elemente, wenn
Objekte verschoben oder verdndert werden. Daher werden Verbindungen auch
iiber die physischen Grenzen der urspriinglichen Geometrie, die vereint wurde,
hinaus beibehalten.

Sie konnen mit der Option "Vereinen" (Combine) eine beliebige Anzahl von
Objekten in beliebiger Kombination verbinden oder gruppieren, z.. B. Flichen,
Komponenten und Beziige. Mit dieser Option konnen Verbindungen logisch
gruppiert und aufrechterhalten werden. Elemente konnen einem vereinten Element,
beispielsweise einem Kombinationsknoten, nach dessen Erstellung auch
hinzugefiigt oder daraus entfernt werden.

Wenn die Geometrie der Elemente eines kombinierten Elements aktualisiert wird,
um eine Verbindung aufrecht zu erhalten, geht der vorherige geometrische Status
verloren. Durch Loschen oder Deaktivieren der Verbindung ldsst sich die
Geometrie der einzelnen Knoten nicht wiederherstellen, wenn sie dem vereinten
Element oder Kombinationsknoten hinzugefiligt werden.
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Wenn eine Vereinen-Verbindung fehlschligt, bleibt der Kombinationsknoten
intakt. Einzelne Verbindungen innerhalb eines Kombinationsknotens konnen
voneinander unabhéngig fehlschlagen.

Die Option "Zusammenfiihren" (Merge) in IDD ist mit der Funktion
"Zusammenfiihren" (Merge) in Creo Parametric identisch. Sie kdnnen nur giiltige
Sammelflichen zusammenfiihren, die durch eine Fliche, eine Komponente, ein
vereintes Element oder einen anderen Zusammenflihrungsknoten dargestellt
werden. Komponenten oder Kombinationsknoten, die keine durchgéngige, giiltige
Sammelflache darstellen, konnen nicht zusammengefiihrt werden.

In zusammengefiihrten Knoten wird der urspriingliche Status der
zusammengefiihrten Sammelfldchen gespeichert. Wenn eine zusammengefiihrte
Komponente oder ein Kombinationsknoten zeitweilig geloscht oder deaktiviert
wird, wird daher die urspriingliche Geometrie der Sammelflichen
wiederhergestellt.

Ein zusammengefiihrtes Element kann die Verbindungen nur auf der Grundlage
der urspriinglichen Sammelfldchen, die urspriinglich vereint wurden, aufrecht
erhalten. Wenn Sie die Komponenten verschieben oder verandern, so dass sich die
Elemente nicht mehr schneiden, dann schlidgt die Zusammenfiihrung fehl und wird
automatisch entfernt.

Zusammenfassung

» Bei der Option "Vereinen" (Combine) werden die Berandungen der
zugehorigen Elemente dauerhaft geédndert, um die Verbindungen beizubehalten.

* Bei der Option "Zusammenfiihren" (Merge) werden die Berandungen der
zugehorigen Elemente nicht verdndert, um die Verbindungen aufrecht zu
erhalten. Stattdessen wird hier versucht, basierend auf den urspriinglichen
Berandungen Schnittpunkte zwischen den Elemente zu bilden, wenn
Anderungen vorgenommen werden.

» Mit der Option "Verkleinern" (Collapse) kann einer Sammelfldche oder einem
Knoten keine Geometrie hinzugefiigt werden. Sie verwenden Verkleinern"
(Collapse) stattdessen, um die Struktur eines vorhandenen
Sammelflichenknotens zu vereinfachen. Beispielsweise konnen Sie nach dem
Verschmelzen und Vereinen von KEs, um die gewiinschte Form zu erhalten,
diese zu einer unstrukturierten, eine Ebene umfassenden
Komponentensammelflache verkleinern.

Geometrie entfernen

Jetzt entfernen Sie unerwiinschte Geometrie mit dem Tool SchlieBen (Close).
Wenn Sie die Geometrie entfernen, werden angrenzende Flachen verlangert oder
getrimmt, um die Offnungen zu konvergieren und zu schlieBen. Es ist aber auch
moglich, dass die ausgewdhlten Flachen wie in diesem Fall geloscht und interne
Schleifen in den angrenzenden Flichen entfernt werden, um die Offnungen zu
schlieen.
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Hinweis

Die Profil- und Drehen-Pseudo-KEs beruhen auf Skizzen, die aus der
ausgewdhlten Geometrie zum Zeitpunkt ihrer Erzeugung extrahiert wurden. Sie
konnen diese Skizzen beim Erzeugen dndern. Oder klicken Sie mit der rechten
Maustaste, klicken Sie im Kontextmenti auf Definition editieren (Edit Definition),
und rufen Sie die IDD-Umgebung auf, um die Registerkarte zum Erzeugen des
Pseudo-KE zu éftnen.

Verwenden Sie das Verfahren zum Auswiéhlen von Kern- und Berandungsflachen,
um die Fldchen auszuwihlen.

1. Halten Sie die STRG-Taste gedriickt, und wéhlen Sie die acht griin
dargestellten Kernflachen aus.

2. Halten Sie die UMSCHALTTASTE gedriickt, und wéhlen Sie die Flichen 2
und 3 aus. Flache 3 befindet sich unter Flache 2.

Wenn Sie die Auswahl der Flichen beendet haben, wird der Kern- und
Berandungsflachensatz hervorgehoben.

3. Wihlen Sie die Befehlsfolge Heilen (Heal) » SchlieBen (Close). Die
Registerkarte IDD-SchlieBenwerkzeug (IDD Close Tool) wird gedffnet, und der
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Flachensatz wird in dem Kollektor angezeigt, der die zu entfernenden Flachen
sammelt.

4. Klicken Sie auf der Registerkarte IDD-SchlieBenwerkzeug (IDD Close Tool) auf
vl
Hinweis

Im GTS-Baum wird kein Knoten erzeugt, wenn Sie SchlieBen (Close)
auswdahlen. Mit dem Befehl Widerrufen (Undo) konnen Sie entfernte Flachen
jedoch wiederherstellen.

Zusammenfassung

Sie haben gelernt, wie eine fehlende Flache mit dem Berandungsverbund-Tool
ersetzt wird, wie Flachen in ein Zylinder- oder Profil-Pseudo-KE konvertiert
werden und wie Geometrie mit dem SchlieBen-Tool entfernt wird. AuBerdem
haben Sie gelernt, das Modell an neue Anforderungen anzupassen.
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Tipps und Techniken
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Die in diesem Kapitel vorgestellten Tipps und Techniken zeigen Ihnen, wie Sie
Spalte schlieBen. Mit Hilfe dhnlicher Techniken konnen Sie die Tangentialitét
zwischen Fliachen reparieren.
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Ausmale einer Reparatur erfassen

Der Umfang einer Reparatur hiangt davon ab, wie viele unabhingige
Komponentenknoten der obersten Ebene (direkte Kinder des Import-KE) in der
IDD-Umgebung enthalten sind. Ist nur ein Komponentenknoten vorhanden, wird
er automatisch zur Reparatur ausgewéhlt. Sind mehrere Knoten vorhanden, miissen
Sie den zu reparierenden Komponentenknoten manuell aktivieren.

Tipp

Aktivieren Sie im GTS-Baum stets zuerst den gewiinschten Knoten, bevor Sie mit
Ihrer Arbeit beginnen. Dies ist hilfreich. Sie kénnen beispielsweise eine Flédche
abtrennen und sie zu einem Basisknoten machen, um die Trimmberandung
manuell neu erzeugen zu konnen.

Wenn sich unmittelbar unter dem Import-KE mehr als ein Komponentenknoten
befindet und Sie den zu reparierenden Knoten nicht aktiviert haben, wird das
Drahtgitter ausgeblendet, und das Reparieren-Tool ist nicht verfiigbar. Wenn Sie
einen Knoten im GTS-Baum aktivieren, beschriankt sich die Reparatur auf die
Flachen des aktiven Knotens. Sie kdnnen eine Reparatur auch einschrianken, indem
Sie auf einer vorhandenen Komponente nur bestimmte Flidchen aktivieren. Es ist
auch moglich, die Fliachen abzutrennen, sie zu einer eigenen Komponente zu
vereinen und anschlieBend die Komponente, die die abgetrennten Flichen enthlt,
zu aktivieren und zu bearbeiten.

Priifen Sie das Drahtgitter vor einer Reparatur. Wenn die Darstellung tiberwiegend
erfiillt ist, d.h. wenn die Kurven des Drahtgitters griin dargestellt werden und nur
wenige schwarz dargestellte Varianten vorhanden sind, sollten Sie nicht versuchen,
die gesamte Komponente zu reparieren. Die Berechnung der Reparatur nimmt viel
Zeit in Anspruch, und einige Flichen werden unter Umstdnden verzerrt.

Auch durch Einfrieren der gesamten Komponente konnen Sie sicherstellen, dass
die Reparatur nur einen isolierten Bereich betrifft. Wéhlen Sie einen
Komponentenknoten im GTS-Baum oder in der grafischen Darstellung aus,

klicken Sie mit der rechten Maustaste, wahlen Sie im Kontextmenii den Befehl
Elternknoten auswahlen (Select Parent Node), und wihlen Sie im Kontextmenti

den Befehl Einfrieren (Freeze). Sie konnen auch auf der Registerkarte Bedingung

definieren (Constrain) die Befehlsfolge Einfrieren (Freezing) > Einfrieren
(Freeze) wihlen. Tauen Sie die an die schwarzen Drahtgitterkurven grenzenden

Flachen auf, um sie zu reparieren.

Allgemeine Einfuhrung: Flachen einfrieren

Durch das Einfrieren werden die fiir eine Fliche zulissigen Anderungen stark
eingeschrinkt, eine Reparatur der Fliache wird jedoch dadurch nicht verhindert.
Lokale Anderungen entlang den Berandungskanten sind weiterhin moglich, auch
wenn die Flache eingefroren ist. Selbst wenn alle aktivierten Flichen eingefroren
sind, konnen sie repariert werden. Wenn eine Fliache eingefroren ist, sind
Anderungen withrend der Reparatur auf Verformungen einer kleinen angrenzenden
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Flache oder Berandung beschriankt. Weder das UV-Parametrisierungsraster noch
die mathematischen Eigenschaften der Fliache dndern sich. Wenn die Fliche jedoch
nicht eingefroren ist, werden durch die Reparatur die Parametrisierungsraster und
Flachen verformt und geéndert.

Die Befehle Einfrieren (Freeze) und Auftauen (Unfreeze) sind stets verfiigbar,
wenn mehrere Flachen mit unterschiedlichen Einfrierzustinden ausgewéahlt
werden. Eingefrorene Flachen sind mit einem speziellen Identifizierungssymbol
markiert. Wenn Sie mit der rechten Maustaste klicken und Auftauen (Unfreeze)
wihlen, werden nur die Flachen aufgetaut, die aufgetaut werden konnen. Die
iibrigen Flichen werden als eingefroren markiert.

Allgemeine Einfuhrung: Flachen auftauen

Manchmal kann eine Flache nicht aufgetaut werden. In diesem Fall kann das
System eine vierseitige oder dreiseitige Einzelfliche anhand ihrer aktuellen
Berandung nicht berechnen. Eine solche Situation ldsst sich umgehen, indem Sie
zwel angrenzende Drahtgitterkurven solcher Flachen zusammenfiihren. Wahlen

Sie die Kurven aus, klicken Sie mit der rechten Maustaste, und klicken Sie auf
Kurven zusammenfiihren (Merge Curves). Dies reicht unter Umstidnden aus, um sie

auftauen zu kOnnen.

Tipp

Wenn die obige Methode nicht funktioniert, verwenden Sie UV-Kurven, um die
Fliche zu unterteilen (erstellen Sie die UV-Kurven, und fiigen Sie sie dem
Drahtgitter Stiick fiir Stiick hinzu) und jedes Stiick einzeln aufzutauen.

Analytische Flachen, einschlieBlich Kugeln, Zylinder und Ebenen, sind
standardméBig eingefroren. Wenn Sie eine analytische Fliche auftauen, wird sie in
eine Freiform-Flache konvertiert, die Sie dndern konnen.

Spalte definieren

Sie miissen einen Spalt als Eingabe fiir das Reparatur-Tool definieren, um ihn
reparieren zu konnen. Ein Spalt wird als schwarze Drahtgitterkurve dargestellt. In
der Regel werden Spalte wihrend des Imports automatisch gefunden und definiert.
Falls angrenzende Paare einseitiger Kanten verbleiben, die nicht in der Darstellung
des Drahtgitters eingeschlossen sind, miissen Sie neue Spalte definieren und sie
dem Drahtgitter hinzufiigen.
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Tipp
Priifen Sie die Drahtgitter-Darstellung sorgfiltig. Achten Sie besonders auf
Bereiche mit schwarzen Drahtgitterkurven mit vielen Eckpunkten. Klicken Sie auf

der Grafiksymbolleiste auf E, um Eckpunkte anzuzeigen. Manchmal sind die
Spalte nicht richtig definiert. Beispielsweise wird im Spalt nur ein Teil der
einseitigen Kante anstelle der vollstindigen Kante angezeigt. Sie konnen dann die
falschen Drahtgitterkurven auswéhlen, auf der Registerkarte Bedingung definieren

(Constrain) die Befehlsfolge . Drahtmodell (Wireframe) » . Aus Drabhtgitter
entfernen (Remove from Wireframe) wéihlen und dann mit dem Tool "Spalte

definieren" (Define Gaps) neue, korrekte Spalte definieren.

In seltenen Fallen lésst sich ein ermittelter Spalt nicht schlieBen. Versuchen Sie,
das Problem mit einer der folgenden Methoden zu l6sen:

*  Verwenden Sie manuelle Tools zum lokalen Editieren, um die Flache
abzutrennen, zu dndern und ihre Berandung zu korrigieren und sie wieder in
die Komponente einzufiigen.

*  Wenn Spalte nicht zum Drahtgitter hinzugefiigt werden oder nach der
Reparatur nicht geschlossen sind, wéhlen Sie die Befehlsfolge Heilen (Heal) »

Schlieen (Close). Die Eingabe fiir das Tool SchlieBen (Close) ist das
schwarze Drahtgitter.

Geometrische Abweichungen beheben

Es gibt zwei Arten geometrischer Abweichungen: eine falsche Flachentrimmung
(fehlerhafte Kanten) oder eine fehlerhafte Flachendefinition (fehlerhafte Flachen).
Diese lokalen geometrischen Abweichungen koénnen eine erfolgreiche Reparatur
verhindern oder fehlerhafte Ergebnisse verursachen. Durch eine geometrische
Abweichung kann das Modell zudem fiir nachgeschaltete Creo Parametric
Applikationen unbrauchbar werden. Bereinigen Sie fehlerhafte Geometrie in IDD
mit Hilfe der manuellen Tools.

Fehlerhafte Reparaturergebnisse bearbeiten

Eine fehlerhafte (verzerrte) Flache ist in der Regel das Ergebnis einer fehlerhaft
ausgefiihrten Reparatur. Suchen Sie die fehlerhafte Fliche, nachdem die Reparatur
im Modell gespeichert wurde, oder verwenden Sie das Tool Reparieren (Repair),
um alte und/oder neue Geometrie anzuzeigen, und fiihren Sie anschliefend eine
Flachenanalyse durch. Die am haufigsten verwendete Analyse ist der

Flachenvergleich. Sie konnen die Optionen verwenden, die auf der Registerkarte
Analysieren (Analyze) von Import DataDoctor verfiigbar sind.

Nach einer Reparatur konnen Sie eine fehlerhafte Flache dadurch beheben, dass
Sie die Flidche 16schen und eine neue Fliche erzeugen. Es ist aber auch moglich,
die Komponente durch Abbrechen der Reparatur oder Klicken auf Widerrufen
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(Undo) in einen Status vor der Reparatur zuriickzuversetzen. Experimentieren Sie
mit dem eingefrorenen Status der Fliche und mit den Tangentialbedingungen an
ihren Kanten, bevor Sie eine erneute Reparatur versuchen.

Gelegentlich erzielen Sie bessere Ergebnisse, wenn Sie die mathematischen
Eigenschaften von Flachen editieren (verringern Sie die Anzahl der Rasterlinien,
wenn sie iibermdBig dicht sind), und/oder verwenden Sie das Tool zum Editieren
von Flachen, um das Kontrollpolygon regelméfiger zu machen.

Tipp
Priifen Sie stets, ob die Fliche, die verzerrt wird, als Ausgangspunkt fiir die
Reparatur ungeeignet ist.

Verwenden der Editieren-Befehle

Verwenden Sie die Optionen, die auf der Registerkarte Editieren (Edit) von Import
DataDoctor verfiigbar sind, um Anderungen an einzelnen Flichen und Kurven
sowie an Berandungskanten von Flidchen vorzunehmen.

Tipp

Falls es moglich ist, werden zweiseitige Kanten erzeugt, wenn Sie die Kanten einer
Komponententliache dndern. Um dies zu verhindern oder um dhnlich wie bei
Verwendung der Funktion zum Editieren von Berandungen zu arbeiten, trennen
Sie die Fliche ab, fiihren Sie an ihren Kanten alle notwendigen Operationen aus,
und legen Sie sie wieder in der Komponente ab.

Die folgenden Tools stehen zur Auswahl:
+  Mit dem Tool "Modify" (Andern) wird eine einseitige Kante mit Hilfe einer
Manipulation des Kontrollpolygons editiert.

*  Mit dem Tool "Eckpunkt bewegen" (Move Vertex) wird ein Eckpunkt
zwischen einseitigen Kanten der gleichen Flache bewegt.

* Mit dem Tool "Zusammenfiihren" (Merge) werden zwei angrenzende einseitige
Kanten zusammengefiihrt.

* Mit dem Tool "Trennen" (Split) wird eine einseitige Kante an einem
ausgewdhlten Punkt getrennt.

» Mit dem Tool "Ldschen" (Delete), wird eine einseitige Kante geloscht.
Hinweis

Das Kantenkontrollpolygon wird vom System nicht gespeichert. Es wird jedes Mal
neu erzeugt, wenn Sie Andern (Modify) verwenden.

Bevor Sie neue Berandungskanten erzeugen konnen, miissen Sie auf der Flache
UV-Kurven erzeugen. Verwenden Sie die Optionen zum Erzeugen von UV-Kurven
auf der Registerkarte Erzeugen (Create) in IDD, um eine ausgewéhlte Kette
einseitiger Kanten durch eine Kette von UV-Kurven zu ersetzen. Sie konnen fiir
Kurven und UV-Kurven die gleichen Editieroperationen verwenden und die neue
Berandung wie gewlinscht formen.
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Fehlerbeheber - Analyse- und
Reparaturverfahren

Auf dem Verwendungszweck basierende Reparaturen .............ccccoivviiiiiiiieiiiiiiinn e, 80

Der Fehlerbeheber in IDD kann eine Reihe eindeutiger Probleme mit der Integritit
der Geometrie melden. Jedes Problem ist mit einer oder mehreren Methoden
reparierbar.

In diesem Kapitel werden die einzelnen Priifungen beschrieben, die IDD als
Suchkriterien zur Ausgabe geometrischer Mangel im Modell verwendet, und wie
diese Mingel behoben werden kénnen.
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Auf dem Verwendungszweck basierende
Reparaturen

Der Fehlerbeheber von IDD priift das Modell auf geometrische Fehler, die sich auf
dessen Umwandlung in Volumenkorper und Aufdickung, die nachfolgende
Erzeugung von Kind-KEs, z.B. Rundungen, oder die nachgeschaltete Nutzung der
importierten Geometrie flir die Fertigung oder den Entwurf von Spritzgussformen,
auswirken konnen, und gibt diese Miangel aus. Die effektive Nutzung des
Fehlerbehebers in IDD setzt Kenntnisse des Verwendungszwecks der importierten
Geometrie voraus, bevor die relevanten Priifungen aktiviert werden. Wéhlen Sie
auf der Multifunktionsleisten-Registerkarte Import DataDoctor die Befehlsfolge

Analysieren (Analyze) » @ Geometriepriifungen (Geometry Checks), um den
Fehlerbeheber in IDD aufzurufen.

Die folgende Tabelle enthilt die Fehlerbeheber-Priifungen, deren Kategorie und
wie sich die betreffenden Mingel auf die Nutzung der importierten Geometrie
auswirken.

Fehlerbeheber-Prifungen und die Auswirkungen der geometrischen
Mangel

Volu-
men-
korper Nachge-
Fehlerbehe- erzeu- |Aufdi- |Kind- schaltete
ber-Prifung |Typ gen cken KEs Verwendung
Fehlerhafte Fehler v v v W
Flachen
Fehlerhafte zwei- | Fehler v v v v
seitige Kanten
Fehlerhafte Fehler v v
Drahtgitterkur-
ven
Mangelhaft tes- | Warnung v
selierte Kanten
Kleine Schleifen | Warnung v v
einseitiger
Kanten
Kurze einseitige | Warnung v v
Kanten
Fehlerhafte Warnung v v
Eckpunkte
Nicht erfiillte Information | v v
Drahtgitter
Nicht erfiillte Information v
Tangentialitat
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Fehlerbeheber-Prifungen und die Auswirkungen der geometrischen
Mangel (Fortsetzung)

Volu-

men-

korper Nachge-
Fehlerbehe- erzeu- |(Aufdi- |Kind- schaltete
ber-Prifung |[Typ gen cken KEs Verwendung
Drahtgittern Information | v
nicht hinzuge-
fligte Spalte
Fast tangentiale |Information v
Kanten
Kleine Flichen |Information v v v
Schmale Flachen |Information v v v

Der Fehlerbeheber ordnet die Priifungen anhand der Qualitit der Geometrie und
nicht deren Verwendungszwecks den Kategorien Fehler, Warnungen oder
Informationen zu.

» Fehler — Dies sind geometrische Miangel, die korrigiert werden miissen. Gemél
den Creo Parametric Standards ist die fehlerhafte Geometrie, z.B. fehlerhafte
Flachen, zweiseitige Kanten oder Drahtgitterkurven, ungiiltig. Diese Méngel
konnen in der nachgeschalteten Nutzung des Modells ernste Probleme
verursachen. Fehler fiihren zu Instabilitédt in der Geometrie und kénnen die
abrupte Beendigung von Creo Parametric zur Folge haben.

*  Warnungen — Dies sind geometrische Méangel, die moglicherweise Fehler sind
und von den Umstidnden abhidngen, welche sie bedingen. Hierbei handelt es sch
um Mingel, wie z.B. mangelhaft tesselierte Kanten, einseitige Kanten mit
kleinen Schleifen oder einseitige Kanten, die kurz sind, und Eckpunkte ohne
zusammenfallende Kanten und Flidchen. Sie miissen entscheiden, ob diese
Kategorie von Mingeln im Modell korrigiert werden soll.

* Information — Dies sind geometrische Méangel, die sich nicht auf die Nutzung
der geometrischen Daten auswirken. Es handelt sich hierbei um Méngel, wie z.
B. kleine oder enge Flichen, nicht erfiillte Drahtgitter, nicht erfiillte
Tangentialitdt, Drahtgittern nicht hinzugefiigte Spalte und Kanten, die fast
tangential sind. Dies sind Eigenschaften des Modells, die fiir Sie interessant
sind und die Sie mdglicherweise mit IDD dndern mochten.

Fehlerhafte Flachen

Der Fehlerbeheber sucht nach Flachen mit konkaven Doménen oder Flidchen mit
parallelen oder fast parallelen Berandungen und meldet sie als Fehler. Diese
Flachen sind stark verzerrt oder weisen fehlerhafte Singularititen auf.
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Fehlerhafte Flachen sind fiir nachgeschaltete Flichenoperationen unbrauchbar, wie
das Aufdicken, Erzeugen von Volumenkdrpern oder die Generierung eines
hochwertigen Werkzeugwegs in der Fertigung. Wenn Sie diese Flichen in
Zusammenfiihrungs- oder Vererbungsoperationen verwenden, propagieren sie ihre
Geometriepriifungen in das Kind-Modell.

Sie konnen mit dem Fehlerbeheber fehlerhafte Flichen identifizieren. Verwenden
Sie die folgenden Methoden zum Analysieren fehlerhafter Flachen:
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Uberpriifen Sie das Modell mit dem Fehlerbeheber von IDD auf fehlerhafte
Flachen, wiéhlen Sie die entsprechenden Diagnoseoptionen im Fehlerbeheber
aus und zoomen Sie zur fehlerhaften Fléche.

Priifen Sie in der schattierten Ansicht, ob Diskrepanzen vorhanden sind, z.B.
Wellen, Ausbuchtungen und scheinbare Bohrungen.

Suchen Sie in der Drahtgitteransicht nach Abweichungen, wie fehlerhafte
Silhouettenkurven und wellige Kanten.

Suchen Sie nach Flichen, die nicht richtig hervorgehoben werden. Das heif3t,
priifen Sie, ob hervorgehobene und nicht hervorgehobene Darstellung
voneinander abweichen.

Suchen Sie nach fehlerhaften Flachennetzen, wie den nachfolgend genannten:
O  Ein sich selbst iiberschneidendes Netz.

O Netzkurven, die durch einen Punkte verlaufen, liegen lokal parallel

zueinander. Dies ist ein Hinweis auf fehlerhafte Singularitét (siehe
Abbildung).
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O  Ein fiir die Flichenform unsinniges Netz.

© Ein dichtes oder ausgediinntes Netz in einem bestimmten Bereich der
Flache. Sie miissen die Netzdichte anpassen, um diesen Netztyp sichtbar zu
machen.

* Suchen Sie nach lokal fehlerhaft schattierten Flachenanalysen, z.B.
Krimmung, Steigung, Zebra usw.

Fehlerhafte Flachen beheben
Sie konnen fehlerhafte Flichen wie folgt beheben:

* Loschen Sie die Fliche, und fiigen Sie mit dem Berandungsverbund-Tool
folgendermallen eine geeignete Ersatzflache hinzu:

1. Klicken Sie mit der rechten Maustaste auf die ausgewéhlte Flache, und
wiahlen Sie im Kontextmenii den Befehl AusschlieRen (Exclude).
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Hinweis

PTC empfiehlt, dass Sie Flidchen grundsétzlich nur dann I6schen, wenn Sie
sich absolut sicher sind, dass die Fldchen nicht bendtigt werden. Sie
kénnen Fléchen stattdessen ausschlieBen, so dass Sie aus der Darstellung
ausgeblendet und in die AusschlieBen-Ablage verschoben werden. Nach
Abschluss der Reparaturen konnen diese Fldchen aus der Ausschlief3en-
Ablage wiederhergestellt und verwendet oder gel6scht werden.

2. Stellen Sie sicher, dass die einseitigen Kanten der angrenzenden Flachen
sauber sind und sich richtig an den Ecken schneiden.

Tipp

Manchmal ist es einfacher, den Berandungsverbund in einer Richtung zu
erstellen und die Kanten in einer anderen Richtung zu ersetzen, nachdem
die Fliche erstellt wurde.

3. Erzeugen Sie den Berandungsverbund.
Hinweis
Das Berandungsverbund-Tool erstellt eine nicht analytische Fliche. Bei
Bedart kénnen Sie die nicht analytische Fldche in eine analytische Fldche

konvertieren, beispielsweise eine planare, extrudierte, zylindrische oder
gedrehte Fliche.

4. Verkleinern Sie die Fliache in die relevante Komponente.
5. Definieren Sie Spalte, und reparieren Sie diese, falls erforderlich.

» In manchen Fillen ist nur ein Teil der Flache fehlerhaft. So entfernen Sie den
fehlerhaften Teil der Flidche, und korrigieren Sie die Fldche mit einem
Berandungsverbund:

1. Erstellen Sie UV-Kurven, um den fehlerhaften Teil der Flache zu isolieren.

2. Trennen Sie die Flache mit Hilfe der UV-Kurven, und 16schen Sie den
fehlerhaften Teil der Fliche.

3. Erstellen Sie eine Berandungsverbundfliche, um die Offhung zu fiillen.
Verkleinern Sie die Fliache in die relevante Komponente.
5. Definieren Sie Spalte, und reparieren Sie diese, falls erforderlich.

* Wenn die allgemeine Form einem der unterstiitzten prozeduralen oder
analytischen Typen dhnelt, z.B. ein fehlerhafter spharischer Eckenradius,
konvertieren Sie die Flache in den unterstiitzten dhnlichen Flachentyp, z.B.
eine planare, extrudierte, zylindrische oder gedrehte Fliche.

1. Waihlen Sie die Fliache.

2. Wihlen Sie als analytischen Typ planar, zylindrisch, extrudiert oder gedreht
aus.

3. Definieren Sie das Drahtgitter, und reparieren Sie die Spalte.

Wenn die Kanten nahe den anderen Flidchen ausgerichtet sind, definieren
Sie Spalte und reparieren diese.

™
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Wenn die Kanten nicht biindig sind, gehen Sie folgendermalien vor:

O Trennen Sie die Fliache ab.
O Loschen Sie ihre Berandung.

O Ersetzen Sie die Kanten der Flache, so dass sie mit den Berandungen
der umgebenden Fléache tibereinstimmen.

O Definieren Sie die Spalte, und reparieren Sie sie.

* In einigen Féllen miissen Sie wie folgt die relevante Flachengeometrie
auflerhalb der IDD-Umgebung erzeugen, beispielsweise eine gespiegelte

Flache:

1. Trennen Sie die relevante Flache in der importierten Geometrie ab, und
beenden Sie IDD.

2. Wihlen Sie die Fliache im Teilemodus aus, kopieren Sie sie, und fligen Sie
sie ein.

Spiegeln Sie die Fldche im Teilemodus um eine Ebene.

Hinweis

Sie miissen die Ebene nicht genau mittig zwischen der zu spiegelnden
Fliche und der Platzierungsposition platzieren. Sie kénnen die Fldchen in
IDD transformieren, um sie auszurichten.

3. Beenden Sie Import DataDoctor.

4. Waibhlen Sie das Import-KE als Ziel fiir den Verkleinerungsvorgang aus, und
wihlen Sie gleichzeitig Geometrie wie Flichen, Bezugs-KEs und
Volumenkdrper-KEs im Modellbaum aus.

5. Klicken Sie auf Modell (Model) » Editieren (Editing) » Geometrie
verkleinern (Collapse Geometry).

Hinweis

Modell (Model) » Editieren (Editing) » Geometrie verkleinern (Collapse
Geometry) ist nur verfiigbar, wenn das Ziel-Import-KE das erste KE in der
Liste der Modellbaum-Elemente ist, die fiir den Verkleinerungsvorgang
ausgewdhlt werden.

6. Wibhlen Sie das Import-KE aus, klicken Sie mit der rechten Maustaste
darauf, und wihlen Sie im Kontextmenii den Befehl Definition editieren
(Edit Definition).

7. Klicken Sie auf der Registerkarte Importieren (Import) auf '+ |, um die
Registerkarte Import DataDoctor (Import DataDoctor) zu 6ffnen und die
IDD-Umgebung aufzurufen.

8. Transformieren Sie die Flidche bei Bedarf, damit sie an die gewlinschte
Position passt.

9. Verkleinern Sie die gespiegelte Fliache und die abgetrennte Fldche in die

relevante Komponente.

10. Definieren Sie Spalte, und reparieren Sie diese, falls erforderlich.
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Hinweis
Creo Parametric tiberpriift fehlerhafte Spritzgusskonstruktionen darauf, ob sie
Selbstiiberschneidungen enthalten. Beispiel:

» Selbstiiberschneidungen in der Sammelfliche — Eine Singularitét oder ein
Konvergenzpunkt in der Fliche. Der Fehlerbeheber in IDD identifiziert dies als
fehlerhafte Fléche.

e Gefaltete Sammelfliche — Eine Fliche, bei der zwei Seiten verbunden sind, so
dass sie eine zweiseitige Kante bilden. Fiir diesen Defekt ist im Fehlerbeheber
keine explizite Priifung erforderlich. Gefaltete Flachen werden beim Aufruf
von IDD automatisch ausgeschlossen.

Fehlerhafte zweiseitige Kanten

Kanten werden als Splines definiert und mit Hilfe von Interpolationspunkten
mathematisch berechnet. Wenn die Interpolationspunkte jeder einseitigen Kante
weit auseinander liegen, werden fehlerhafte zweiseitige Kanten erzeugt. Der
Fehlerbeheber ordnet diesen Defekt der Kategorie Fehler zu.

Profiloptionen steuern das Verbinden von Flachen nach Ebenen und das Erzeugen
von Volumenkoérpern aus dem Modell. Beim Einsatz dieser Optionen versucht
Creo Parametric, die Flichen nach Ebenen zu verbinden, die Sammelfldchen zu
schlieBen und Volumenkdrper aus dem Modell zu erzeugen. Fehlerhafte
zweiseitige Kanten konnen auftreten, wenn Sie wéhrend des Importierens des
Modells Flichen stark extrapolieren, um Spalte zu schlieBen.

Eine fehlerhafte zweiseitige Kante kann entlang der Kante unterbrochene Spalte
aufweisen. Diese Kanten verhindern das Erzeugen von Volumenkdrpern oder
Aufdicken der Geometrie. Fehlerhafte zweiseitige Kanten konnen auch Anzeichen
fiir eine Beschadigung der Geometrie sein, die Sie fiir die nachgeschaltete
Verwendung des Modells beheben miissen. Fehlerbeheber zeigt diese Miangel als
Fehler an, die korrigiert werden miissen.

Die meisten fehlerhaften zweiseitigen Kanten konnen wie folgt korrigiert werden:
1. Wihlen Sie auf der Registerkarte Bedingung definieren (Constrain) die

Befehlsfolge . Drahtmodell (Wireframe) > . Aus Drahtgitter entfernen
(Remove from Wireframe), um ein griines Drahtgitter zu entfernen und die

entsprechende zweiseitige Kante in zwei einseitige Kanten zu konvertieren.

2. Verdndern Sie die Kanten wie folgt:

* In einfachen Fillen fiithren Sie Kanten mit Hilfe von Tools zusammen,
bearbeiten diese und bereinigen die einseitigen Kanten mit dem Tool
"Eckpunkt verschieben" (Move Vertex).

* In komplizierteren Féllen miissen Sie die fehlerhaften Kanten durch UV-
Kurven ersetzen.

* In einigen duBerst komplexen Féllen miissen Sie die gesamte Berandung
wie folgt neu erzeugen:
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a. Trennen Sie die Flache ab, die iiber fehlerhafte Kanten verfiigt.

Wihlen Sie eine der Kanten aus, klicken Sie mit der rechte Maustaste,
und wihlen Sie im Kontextmenii den Befehl Loschen (Delete), oder
driicken Sie die Delete-Taste.

c. Erzeugen Sie mit dem UV-Kurven-Tool und dem Ersetzen-Tool eine
neue Berandung.

d. Schneiden Sie die neue Flache aus, und fligen Sie sie in die
Komponente ein, oder ziehen Sie sie in die Komponente.

3. Erzeugen Sie das Drahtgitter neu.

4. SchlieBen Sie den Spalt mit dem Reparieren-, Angleichen- oder SchlieSen-
Tool.

Fehlerhafte Drahtgitterkurven

Ein fehlerhaftes Drahtgitter tritt auf, wenn fiir ein Paar einseitiger Kanten
unterschiedlicher Lénge ein schwarzes Drahtgitter erzeugt wird. Diese Drahtgitter
werden beim Aufruf von IDD automatisch von IDD erstellt. Sie werden auch
erzeugt, wenn Drahtgittern Spalte hinzugefiigt werden. Die zweiseitigen Kanten,
die als griine Drahtgitter angezeigt werden, werden von der Priifung auf fehlerhafte
Drahtgitter ausgeschlossen. Fehlerbeheber ordnet fehlerhafte Drahtgitter der
Kategorie Fehler zu.

Mit dem Reparieren- und Angleichen-Tool kdnnen fehlerhafte Drahtgitter
geschlossen werden, die Ergebnisse konnen jedoch in kiinftigen
Reparaturprozessen zu Problemen fiihren. Nicht alle fehlerhaften Drahtgitter lassen
sich jedoch mit den Tools "Angleichen" (Match), "Reparieren" (Repair) und
"Schlieen" (Close) schlieen.

Die Priifung auf fehlerhafte Drahtgitterkurven identifiziert Offnungen im Modell,
die das Erzeugen von Volumenkorpern oder das Aufdicken der importierten
Geometrie verhindern. Sie miissen diese vom Fehlerbeheber als Fehler
bezeichneten fehlerhaften Drahtgitter entfernen und die zugrunde liegenden
Kanten bearbeiten, bevor Sie die ordnungsgeméfen Drahtgitter erzeugen.

Welche Technik zum Korrigieren dieses Fehlers zu verwenden ist, wird durch die
beabsichtigten Ergebnisse bestimmt. Sie konnen folgendermallen vorgehen:

1. Waihlen Sie auf der Registerkarte Bedingung definieren (Constrain) die

Befehlsfolge . Drahtmodell (Wireframe) » . Aus Drahtgitter entfernen
(Remove from Wireframe), um den Spalt aus dem Drahtgitter entfernen und die

entsprechende zweiseitige Kante in zwei einseitige Kanten zu konvertieren.
» Verwenden Sie bei Kurvensegmenten gleicher Lénge die Befehlsfolge

R i
Editieren (Edit) » Kurven zusammenfiihren (Merge Curves), um die
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benachbarten einseitigen Kanten zu einzelnen einseitigen Kanten zu
kombinieren.

* Bei Kurvensegmenten unterschiedlicher Lénge trennen Sie die lange Kurve

mit der Befehlsfolge Editieren (Edit) » Kurve trennen (Split Curve) am
Eckpunkt der kurzen Kurve.

Hinweis
Dadurch kann eine kurze Kante erzeugt werden.

2. Definieren Sie mit dem Such-Tool oder dem Tool "Spalte definieren" (Define
Gaps) einen neuen Spalt.

3. Fiigen Sie den neuen Spalt dem Drahtgitter mit der Befehlsfolge

Drahtmodell (Wireframe) » . Zu Drahtgitter hinzufiigen (Add to Wireframe)
auf der Registerkarte Bedingung definieren (Constrain) hinzu.

4. Schlielen Sie den Spalt mit dem Reparieren-, Angleichen- oder Schlieen-
Tool.

Mangelhaft tesselierte Kanten

Kanten werden als Splines definiert und mit Hilfe von Interpolationspunkten
mathematisch berechnet. Eine gute und klar definierte einseitige Kante verfiigt
iiber eine addquate Dichte gleichméBig verteilter Interpolationspunkte.

Mangelhaft tesselierte einseitige Kanten verfiigen iiber zu wenige oder
ungleichmiBig verteilte Interpolationspunkte. Eine korrekte zweiseitige Kante
verfligt iber gleichmaBig verteilte Interpolationspunkte und an jeder der
einseitigen Eltern-Kanten {iber eine dquivalente Dichte von Punkten. Mangelhaft
tesselierte zweiseitige Kanten treten auf, wenn die Interpolationspunkte der
einzelnen einseitigen Kanten eine relativ kleine, aber signifikante Entfernung weit
auseinander liegen. Mangelhaft tesselierte Kanten werden von Fehlerbeheber der
Kategorie Warnungen zugeordnet.
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2. Definieren Sie einen Spalt mit dem Such-Tool oder dem Tool 'Spalt !
definieran’, die im Reparaturmodus verfligbar sind.

3. Fugen Sie dem Drahtgitter den Spalt mit dem Tool Zu Drahtgitter

Mangelhaft tesselierte Kanten verhindern nicht die Erzeugung von
Volumenkorpern aus der Geometrie, konnen jedoch zu Verzerrungen und anderen
unerwiinschten geometrischen Ergebnissen flihren. Durch die Reparatur
mangelhaft tesselierter Kanten werden geometrische Ergebnisse verbessert, die in
den meisten Féllen nicht sichtbar sind. Wenn mangelhaft tesselierte Kanten nicht
repariert werden, konnen sie sich nachteilig auf Kind-KEs und die nachgeschaltete
Verwendung der importierten Geometrie auswirken.

Mangelhaft tesselierte zweiseitige Kanten verursachen mit hoherer
Wahrscheinlichkeit Probleme als mangelhaft tesselierte einseitige Kanten.
Mangelhaft tesselierte zweiseitige Kanten werden aus mangelhaft tesselierten
einseitigen Kanten erzeugt. Daher miissen Sie die fehlerhaften einseitigen Kanten
unbedingt reparieren.

Gehen Sie beim Reparieren mangelhaft tesselierter Kanten folgendermallen vor:
1. Waihlen Sie auf der Registerkarte Bedingung definieren (Constrain) die

Befehlsfolge . Drahtmodell (Wireframe) > . Aus Drahtgitter entfernen
(Remove from Wireframe), um eine zweiseitige Kante in zwei einseitige Kanten

zu konvertieren. Bei einer der Kanten kann ein Problem auftreten. Dieser
Schritt ist bei fehlerhaften einseitigen Kanten nicht erforderlich.

2. Klicken Sie im Fehlerbeheber mit der rechten Maustaste auf die Diagnose fiir

die mangelhaft tesselierte Kante, und wihlen Sie im Kontextmenii den Befehl
Problemgeometrie wahlen (Select Problem Geometry).

3. Waihlen Sie die Befehlsfolge Editieren (Edit) » Andern (Modify). Das
Dialogfenster Kurve andern (Curve Modify) wird gedftnet.

Fehlerbeheber - Analyse- und Reparaturverfahren ]9




*  Wenn die Kante iiber zu wenige Interpolationspunkte verfiigt, fligen Sie ihr
Interpolationspunkte hinzu und verteilen diese neu, damit die Punkte den
gleichen Abstand voneinander haben.

*  Wenn die Interpolationspunkte zusammengeklumpt sind, verteilen diese
neu, damit die Punkte den gleichen Abstand voneinander haben.

* Klicken Sie auf OK.

4. Definieren Sie mit dem Such-Tool oder dem Tool "Spalte definieren" (Define
Gaps) einen Spalt.

5. Fiigen Sie den Spalt dem Drahtgitter mit der Befehlsfolge . Drahtmodell

(Wireframe) > . Zu Drahtgitter hinzufiigen (Add to Wireframe) auf der
Registerkarte Bedingung definieren (Constrain) hinzu.

6. Korrigieren Sie den Spalt mit dem Reparieren-, Angleichen- oder Schlie3en-
Tool.

Kleine Schleifen einseitiger Kanten

Sammelflichen konnen innerhalb einer einzelnen Flachen oder an den
Schnittpunkten von zwei oder mehr Flichen Offnungen oder Schleifen von
einseitigen Kanten aufweisen. Mit der Priifung auf Schleifen einseitiger Kanten
werden diese kleinen Schleifen identifiziert. Die kleine BemafBung der Schleifen
wird mit Hilfe eines Schwellenwerts quantifiziert. Der Standardschwellenwert ist
10 Mal so grof3 wie die absolute Genauigkeit des Modells und gilt fiir den Umfang
der Offnung. Der Fehlerbeheber ordnet diesen Defekt der Kategorie Warnung zu.

Sie konnen aus Modellen, die kleine Schleifen einseitiger Kanten enthalten, keine
Volumenkdrper erzeugen.

Abhéngig von ihrer Topologie konnen Sie folgende Methoden zum Reparieren
kleiner Schleifen einseitiger Kanten einsetzen:

«  Wenn sich die Offnung wie gezeigt innerhalb der Berandung einer einzelnen
Flache befindet, wihlen Sie eine der Kanten des Umfangs aus und 10schen sie.

™
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1. Waihlen Sie auf der Registerkarte Bedingung definieren (Constrain) die
Befehlsfolge . Drahtmodell (Wireframe) » EE Aus Drahtgitter entfernen

(Remove from Wireframe), um das umgebende griine Drahtgitter zu
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entfernen und die entsprechende zweiseitige Kante in zwei einseitige
Kanten zu konvertieren.

2. Ordnen Sie die Eckpunkte an.
Erzeugen Sie das Drahtgitter neu.

4. Schlielen Sie den Spalt mit dem Reparieren-, Angleichen- oder Schlie3en-
Tool.

Kurze einseitige Kanten

Kurze einseitige Kanten sind schwer anzuzeigen. Sie konnen sie mit dem
Fehlerbeheber vergroBern, um sie besser reparieren zu konnen. Die kurze Lange
der Kanten wird mit einem Schwellenwert quantifiziert. Der
Standardschwellenwert entspricht der absoluten Genauigkeit des Modells und gilt
fiir die Lénge einer einzelnen einseitigen Kante. Der Fehlerbeheber ordnet kurze
einseitige Kanten der Kategorie Warnungen zu.

Aus Modellen, die kurze einseitige Kanten enthalten, konnen keine Volumenkorper
erzeugt werden. Sie konnen Drahtgitter hinzufiigen und Spalte schlieen, um
Volumenkorper aus dem Modell zu erzeugen, dies kann jedoch zu Fehlern in
nachfolgend erzeugten KEs und Schwierigkeiten bei der nachgeschalteten
Verwendung der importierten Geometrie fiihren. Durch das Entfernen kurzer
Kanten oder das Verldngern dieser Kanten, so dass sie gro3er als die Genauigkeit
des Modells sind, wird die Qualitit des Modells fiir die nachgeschaltete Nutzung
erhoht.

Die Geometrie, die die kurzen einseitigen Kanten umgibt, bestimmt die
Reparaturmethode folgendermal3en:

« Wenn die kurze einseitige Kante, wie gezeigt, tangential oder nahezu tangential
zu einer angrenzenden Kante ist, dann gilt Folgendes:

1 Tangentiale oder nahezu tangentiale kurze Kante
1. Wihlen Sie auf der Registerkarte Bedingung definieren (Constrain) die
Befehlsfolge . Drahtmodell (Wireframe) > . Aus Drahtgitter entfernen
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(Remove from Wireframe), um das Drahtgitter aus der angrenzenden Kante
zu entfernen.

2. Kombinieren Sie die Segmente.
Erzeugen Sie das Drahtgitter neu.

4. Schlielen Sie den Spalt mit dem Reparieren-, Angleichen- oder Schlielen-
Tool.

*  Wenn die kurze einseitige Kante wie gezeigt tangential zu einer angrenzenden
Kante sein muss, gilt Folgendes:

r

i

1 Die kurze einseitige Kante, die tangential sein muss

1. Waihlen Sie auf der Registerkarte Bedingung definieren (Constrain) die

Befehlsfolge . Drahtmodell (Wireframe) » ! Aus Drahtgitter entfernen
(Remove from Wireframe), um das Drahtgitter aus der angrenzenden Kante

zu entfernen.

2. Verschieben Sie den gemeinsamen Eckpunkt so, dass die Kanten nahezu
tangential sind.

3. Kombinieren Sie die Segmente.
4. Erzeugen Sie das Drahtgitter neu.

5. SchlieBen Sie den Spalt mit dem Reparieren-, Angleichen- oder Schlie3en-
Tool.

* Wenn die kurze einseitige Kante wie gezeigt nicht tangential zu einer
angrenzenden Kante ist und auch nicht tangential sein darf, gilt Folgendes:

1 Die kurze Kante, die nicht tangential sein darf
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1. Definieren Sie ein schwarzes Drahtgitter fiir das kurze einseitige

Kantenpaar.
2. SchlieBen Sie den Spalt mit dem Reparieren-, Angleichen- oder Schlief3en-
Tool.
Hinweis

Mit der Konturpriifung in Creo Parametric Spritzguss kann nach einer Schleife
oder allen Schleifen von einseitigen Kanten gesucht werden. Bei der von
Fehlerbeheber in IDD durchgefiihrten Priifung auf kleine Schleifen einseitiger
Kanten werden alle Schleifen ausgegeben, die schwer zu sehen oder zu finden
sind. GroBe offene Schleifen sind im Modell jedoch sichtbar.

Fehlerhafte Eckpunkte

Ein fehlerhafter Eckpunkt ist eine Position, an der die Endpunkte von zwei
aufeinander folgenden Flachenkantensegmenten nicht zusammenfallen. Der
Fehlerbeheber in IDD ordnet diesen Defekt der Kategorie Warnung zu.

Das Erzeugen von Volumenkdrpern oder Aufdicken des Modells wird durch
fehlerhafte Eckpunkte nicht verhindert, sie konnen sich jedoch auf Kind-KEs und
die nachgeschaltete Verwendung der importierten Geometrie auswirken.

Das Reparaturverfahren hiangt von der Geometrie ab, welche die fehlerhaften
Eckpunkte umgibt.

*  Wenn sich ein fehlerhafter Eckpunkt wie gezeigt auf den parallelen Kanten
befindet, dann gilt Folgendes:
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1. Yerwenden Sie das Toal 'Eckpunkt bewegen', w --?

1 Kanten miissen am gleichen Punkt zusammentreffen

1. Entfernen Sie die Drahtgitter, sofern vorhanden, von den Kanten des
fehlerhaften Eckpunkts.

oa
2. Waihlen Sie die Befehlsfolge Editieren (Edit) » Kurven zusammenfiihren
(Merge Curves), um die benachbarten einseitigen Kanten zu einzelnen

einseitigen Kanten zu kombinieren.
3. Erzeugen Sie das Drahtgitter neu.

4. Schlielen Sie den Spalt mit dem Reparieren-, Angleichen- oder SchlieBen-
Tool.

»  Wenn sich wie gezeigt ein fehlerhafter Eckpunkt an der Ecke einer Fliache
befindet, gilt Folgendes:
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1. Yenwenden Sie daz Tool 'Eckpunkt bewegen', b

1 Eckpunkt befindet sich nicht am Schnittpunkt von Kanten

Trennen Sie die Fldche mit dem fehlerhaften Eckpunkt von der
Komponente ab.

Klicken Sie im Fehlerbeheber mit der rechten Maustaste auf den relevanten
Knoten, und wihlen Sie im Kontextmenii den Befehl Problemgeometrie
wahlen (Select Problem Geometry).

Klicken Sie im Arbeitsfenster mit der rechten Maustaste auf die

hervorgehobene Geometrie, und wéhlen Sie im Kontextmenii den Befehl
Aus Drahtgitter entfernen (Remove from Wireframe).

Einige Eckpunkte gelten als fehlerhaft, wenn sich die konstituierenden
Flachen nicht am selben Punkt schneiden. In komplexen Fillen,
beispielsweise wenn einige dieser Flachen eingefroren sind, dndert das
Reparieren-Tools die Flachen nicht, so dass sie sich geometrisch schneiden,
und es wird ein fehlerhafter Eckpunkt erzeugt. In manchen Féllen konnen
Sie das Problem mit den Tools "Transformieren" (Transform) oder "Form
andern" (Modify Shape) beheben.

©  Wenn der fehlerhafte Eckpunkt im Fehlerbeheber nicht mehr angezeigt
wird, wird der fehlerhafte Eckpunkt beim Schlieen des Spalts erzeugt
und durch eine mangelhafte Ausrichtung der Flachen verursacht.
Reparieren Sie diesen Defekt wie folgt:

a. Analysieren Sie die Flachen, und ermitteln Sie, welche Flache nicht
an der librigen Sammelfléche ausgerichtet ist.
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b. Verschieben Sie die Flache mit dem Transformieren-Tool so, dass
sie biindig an der restlichen Sammelflidche ausgerichtet ist.

O Wenn der fehlerhafte Eckpunkt in Fehlerbeheber weiterhin als Warnung
angezeigt wird, ist er innerhalb einer einzelnen Fliche fehlerhaft.
Reparieren Sie diesen Defekt wie folgt:

a. Klicken Sie im Fehlerbeheber mit der rechten Maustaste auf den
relevanten Knoten, und wahlen Sie im Kontextmenii den Befehl
Problemgeometrie wahlen (Select Problem Geometry).

b. Klicken Sie im Arbeitsfenster mit der rechten Maustaste auf die
hervorgehobene Geometrie, und wéhlen Sie im Kontextmenii den
Befehl Abtrennen (Detach).

c. Verschieben Sie den fehlerhaften Eckpunkt derart, dass er an der
vorhandenen Ecke der Komponente einrastet. Der fehlerhafte
Eckpunkt wird beim Verschieben repariert.

d. Vereinen Sie die Fliache wieder mit der Komponente, und
verkleinern Sie sie.

4. FErzeugen Sie ggf. fehlende Drahtgitter bei Bedarf neu.

5. SchlieBBen Sie den Spalt mit dem Reparieren-, Angleichen- oder Schlief3en-
Tool.

Nicht erfullte Drahtgitter

Erfiillte Drahtgitter stellen zweiseitige Kanten dar und sind griin. Nicht erfiillte
Drahtgitter reprasentieren definierte Spalte, die den Drahtgittern hinzugefiigt
wurden und nicht geschlossen sind, und werden schwarz dargestellt. Der
Fehlerbeheber in IDD {iberpriift und meldet schwarze Drahtgitter im Modell zur
Information. Nicht erfiillte Drahtgitter enthalten keine fehlerhafte
Drahtgittergeometrie.

Modelle mit nicht erfiillten Drahtgittern konnen nicht in Volumenkorper
umgewandelt oder aufgedickt werden. Diese Drahtgitter konnen automatisch
geschlossen und in erfiillte Drahtgitter konvertiert werden, wenn Sie die Eckpunkte
verschieben oder das Tool "Vereinen" (Combine), "Zusammenfiihren" (Merge)
oder "Verkleinern" (Collapse) verwenden. Sie konnen mit dem Tool "Angleichen"
(Match), "Reparieren" (Repair) oder "Schlieen" (Close) nicht erfiillte Drahtgitter
reparieren.
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Nicht erfullte Tangentialitat

Nicht erfiillte Tangentialitét stellt eine definierte Tangentialbedingung an einer
zweiseitigen Kante dar, die nicht erfiillt wurde. Tangentialbedingungen werden
beim Aufruf der IDD-Umgebung automatisch anhand des Winkels zwischen den
angrenzenden Flachen an jeder zweiseitigen Kante definiert. Der Fehlerbeheber
ordnet diese Bedingung der Kategorie "Informative Priifung" zu.

Sie miissen nicht erfiillte Tangentialitdten nicht reparieren, um einen
Volumenkdrper aus einem Modell erzeugen oder eine Sammelfléche versetzen zu
konnen, sie konnen sich jedoch auf die nachgeschaltete Verwendung der
Geometrie auswirken. Fertigungswerkzeugpfade oder ein Kunststoftteil fiir die
Produktion kénnen deutlich Tangentialitét zeigen, die im Modell nicht repariert
wurde.

IDD enthélt verschiedene Tools, mit denen Sie Tangentialbedingungen im Rahmen
anderer Operationen reparieren konnen. Verwenden Sie das Tool "Reparieren"

(Repair) oder "Angleichen" (Match) und aktivieren Sie das Kontrollkastchen
Tangentialitat reparieren (Repair Tangency) auf der Registerkarte Reparieren
(Repair) oder Angleichen (Match), um eine nicht erfiillte Tangentialitit zu

reparieren. Mit dem Reparieren-Tool kdnnen Sie eine solche Tangentialitdt nicht
reparieren, wenn alle fiir die Reparatur erforderlichen Flichen eingefroren sind.

Das Ausrichten-Tool repariert Tangentialitét, funktioniert jedoch nur fiir Freiform-
Flachen. Verwenden Sie das Ausrichten-Tool wie folgt:

1. Waibhlen Sie die Flache aus, driicken Sie die rechte Maustaste, und wihlen Sie
im Kontextmenii den Befehl Abtrennen (Detach).

2. Wihlen Sie eine Berandungskante der Fldche aus, driicken Sie die rechte
Maustaste, und wihlen Sie im Kontextmenii den Befehl Loschen (Delete).

3. Wihlen Sie eine resultierende Flache, und klicken Sie auf Editieren (Edit) »
Ausrichten (Align).
Hinweis
Ausrichten (Align) ist nicht fiir analytische Fldchen verfiigbar. Sie konnen die
mathematischen Eigenschaften dieser Fldchen dndern, um sie in Freiform-
Flichen zu konvertieren.

4. Richten Sie die gewiinschte Kante oder Kanten mithilfe der Optionen auf der
Registerkarte Ausrichten (Align) aus.

Entfernen Sie mit dem Tool "Tangentialitit entfernen" (Remove Tangency) die
nicht erforderliche nicht erfiillte Tangentialitét.

™

98 Erste Schritte mit Creo® Parametric Import DataDoctor ™ 2.0



Drahtgittern nicht hinzugefugte Spalte

Ein Spalt ist ein Paar einseitiger Kanten, die nahe beieinander liegen und nicht Teil
des Drahtgitters sind. Einseitige Kanten, die diese Kriterien erfiillen, reprasentieren
meist Offnungen in der importierten Geometrie, die geschlossen werden miissen.
Der Fehlerbeheber ordnet Spalte, die Drahtgittern nicht hinzugefiigt wurden, der
Kategorie "Informative Priifung" zu.

IDD sucht nach Spalte und fiigt sie automatisch den Drahtgittern hinzu, wenn Sie
die IDD-Umgebung aufrufen. Der Standardschwellenwert fiir Spalte ist 7,5 Mal so
grof3 wie die Genauigkeit des Modells. Sie konnen den Standardschwellenwert im
Such-Tool angeben, wenn Sie nach Spalten suchen, und im Fehlerbeheber, um
Spalte zu erkennen, die keinem Drahtgitter hinzugefiigt wurden. Erh6hen Sie den
Schwellenwert, um zusétzliche Spalte zu finden, die keinem Drahtgitter
hinzugefiigt wurden.

So fligen Sie Spalte Drahtgittern hinzu:

1. Klicken Sie im Fehlerbeheber mit der rechten Maustaste auf die Diagnose fiir
nicht zu Drahtgittern hinzugefiigte Spalte, und wéhlen Sie im Kontextmenii
den Befehl Problemgeometrie wahlen (Select Problem Geometry).

2. Klicken Sie mit der rechten Maustaste, und wéhlen Sie im Kontextmenii den
Befehl Zu Drahtmodell hinzufiigen (Add to Wireframe).

Sie konnen mit dem Fehlerbeheber alle zu keinem Drahtgitter hinzugefiigten
Spalte oder einen einzelnen zu keinem Drahtgitter hinzugefiigten Spalt wéhlen.
Allerdings konnen Sie im Fehlerbeheber keine Teilmenge der keinem Drahtgitter
hinzugefiigten Spalte in der Liste auswihlen, weil der Fehlerbeheber keine
Mehrfachauswahl unterstiitzt.

Um eine Teilmenge von Spalten, die keinem Drahtgitter hinzugefiigt wurden, zu
identifizieren und auszuwihlen, konnen Sie den folgenden alternativen Ansatz
verfolgen:

1. Aktivieren Sie das Such-Tool.
2. Legen Sie Spalte als KE-Typ fest.

3. Legen Sie die gewiinschte Standardspaltbreite fest.

4. Suchen Sie nach Spalten.

5. Sammeln Sie die gewiinschten Flichen im Such-Tool, und klicken Sie auf OK.
6. Wibhlen Sie die Befehlsfolge Drahtmodell (Wireframe) » Zu Drahtgitter

hinzufiigen (Add to Wireframe) auf der Registerkarte Bedingung definieren
(Constrain).

Fast tangentiale Kanten

Fast tangentiale Kanten sind solche Kanten, bei denen die Eltern-Flachen einer
zweiseitigen Kante tangential oder fast tangential innerhalb des gegebenen
Winkels sind, fiir die jedoch keine Tangentialbedingung definiert wurde. Der
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Standardwinkel betrdgt 5 Grad. Um tangentiale Flachen ohne Tangentialbedingung
zu identifizieren, legen Sie den Schwellenwert auf Null fest. Der Fehlerbeheber
meldet dies als "Informative Priifung".

Die fast tangentialen Kanten verhindern nicht die Erzeugung von Volumenkorpern
oder das Aufdicken der importierten Geometrie. Dies kann sich auf die Qualitit
des fertigen Produkts auswirken, z.B. auf die Darstellung von Flachen oder
Fertigungswerkzeugpfade.

Sie konnen mit dem Tool "Tangentialitdt hinzufiigen" (Add Tangency) manuell
Tangentialbedingungen einer zweiseitigen Kante hinzufiigen. Durch das
Hinzufiigen der Tangentialbedingung kann die Tangentialitit unter Umstéinden
automatisch behoben werden. Sie konnen die Tangentialitdt zwischen zwei
eingefrorenen Flidchen nur dann reparieren, wenn die Flachen bereits tangential
sind. Aktivieren Sie im Fehlerbeheber das Kontrollkédstchen Ignorieren (Ignore),
um die fast tangentialen Kanten auszublenden, die der Fehlerbeheber identifiziert
hat, wenn keine Tangentialitdt erwiinscht ist.

Kleine Flachen

Eine kleine Flache hat einen Umfang, der kleiner ist als das Zweifache des
Schwellenwerts. Der Standardschwellenwert ist dquivalent mit der absoluten
Genauigkeit des Modells. Der Fehlerbeheber in IDD ordnet diesen Defekt der
Kategorie "Informative Priifung" zu.

Kleine Flachen beeintrachtigen die Modellqualitit wegen ihrer GroBe. Sie konnen
sich auf andere Reparaturvorginge auswirken und verhindern die Erzeugung von
Volumenkorpern aus dem Modell. Sie verhindern hdufig das Aufdicken der
Sammelflachen. Kleine Flachen konnen sich auch auf nachfolgende Erzeugung
von KEs oder die nachgeschaltete Verwendung des Modells auswirken. Durch die
Eliminierung kleiner Flaichen aus dem Modell wird die Modellqualitit erhoht.

So entfernen Sie kleine Flachen:

1. Klicken Sie im Fehlerbeheber mit der rechten Maustaste auf die Diagnose fiir

kleine Flachen, und wahlen Sie im Kontextmenii den Befehl Problemgeometrie
wahlen (Select Problem Geometry).

2. Klicken Sie mit der rechten Maustaste, und wihlen Sie Léschen (Delete).

SchlieBen Sie den resultierenden Spalt mit Hilfe der Techniken, die im
Abschnitt zu kleinen Schleifen einseitiger Kanten beschrieben wurden.

Hinweis
Die Priifung auf kleine Flachen im Spritzguss-Modul von Creo Parametric ist
identisch mit der Priifung auf kleine Fldchen im Fehlerbeheber von IDD.
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Schmale Flachen

Sie konnen schmale Fliachen anhand des Flacheninhalts identifizieren. Eine
schmale Fliche hat einen Flacheninhalt, der kleiner als das durch zwei geteilte
Produkt von Umfang und Schwellenwert ist. Der Standardschwellenwert entspricht
der absoluten Genauigkeit des Modells. Kleine Flichen werden automatisch von
dieser Priifung ausgeschlossen. Der Fehlerbeheber ordnet schmale Flachen der
Kategorie "Informative Priifung" zu.

Schmale Flachen konnen bei der nachfolgenden Erzeugung von KEs oder der
nachgeschalteten Nutzung des Modells Probleme verursachen, weil ihre relative
Grofe und die Genauigkeit des Modells dquivalent sind. Die Eliminierung
schmaler Flachen ist zwar optional, kann jedoch die Modellqualitét erhohen.

Geometrisch sind Splitter und schmale Flachen dquivalent. Topologisch gesehen,
verfiigt eine Splitterfliche liber zwei Ketten schwarzer und griiner
Drahtgitterkurven als Berandungen und moglicherweise tiber einige einseitige
Kanten zwischen diesen Ketten. Diese Drahtgitterbedingung stellt den
Hauptunterschied zwischen einer Splitterfliche und einer schmalen Flache dar
(siche Abbildung).
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Wenn eine schmale Flache die Kriterien einer Splitterfliche erfiillt, konnen Sie die
schmale Flache als Splitter definieren und sie dem Drahtgitter hinzufiigen. Die
Diagnose fiir die schmale Fliche &ndert sich im Fehlerbeheber darauthin in eine
Diagnose fiir einen nicht erfiillten Drahtgitterknoten. Sie kdnnen anschlieend das
Reparieren-Tool verwenden, um in einem Schritt die Splitterfliche zu entfernen
und den resultierenden Spalt zu schliefen.

Wenn das Modell viele schmale Flachen aufweist, ist es effektiver, die schmalen
Flachen mit Hilfe von Massenmethoden in Drahtgitter zu konvertieren. Mit dem
folgenden Verfahren lassen sich die meisten schmalen Fléchen in schwarze
Drahtgitter konvertieren:

Suchen Sie alle Spalte, und fiigen Sie diese dem Drahtgitter hinzu.

2. Verwenden Sie das Such-Tool folgendermaf3en, um Splitterflichen zu
identifizieren und zu sammeln:

a. Aktivieren Sie das Such-Tool.
b. Legen Sie Splitter als KE-Typ fest.

c. Legen Sie den gewiinschten Schwellenwert fiir Splitter fest.
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d. Suchen Sie nach Splittern.

e. Sammeln Sie die erforderlichen Splitter im Such-Tool.

f. Klicken Sie auf OK.

3. Fiigen Sie die Splitter dem Drahtgitter hinzu.

Wenn das Modell nur aus einigen wenigen schmalen Flachen besteht oder wenn
die schmalen Fldchen nicht als Splitter definiert werden kdnnen, kdnnen Sie die
schmalen Flachen wie folgt manuell reparieren:

*  Wenn sich die schmalen Flichen wie dargestellt in der Mitte einer
Sammelfldche befinden, definieren Sie die schmalen Flachen als Splitter und
fiigen diese den Drahtgittern hinzu.
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1. Wihlen Sie auf der Registerkarte Bedingung definieren (Constrain) die

Befehlsfolge Spalten/Splitter (Gaps/Slivers) » @ Splitter definieren
(Define Sliver). Das Dialogfenster Splitter definieren (Define Slivers) wird

geoffnet.

2. Wihlen Sie die schmale Flache im Modell aus, und schlieBen Sie das
Dialogfenster Splitter definieren (Define Slivers).

3. Klicken Sie auf Zu Drahtgitter hinzufiigen (Add to Wireframe).

Hinweis

Die Diagnose fiir die schmale Fliache verschwindet aus dem Fehlerbeheber,
wenn Sie die schmale Fliche dem Drahtgitter hinzufiigen. Sie dndert sich in
eine Diagnose fiir einen nicht erfiillten Drahtgitterknoten.

4. Reparieren Sie das Drahtgitter mit den Techniken, die im Abschnitt zu
nicht erfiillten Drahtgittern beschrieben wurden.

*  Wenn sich die schmale Flache an der Kante einer Sammelflache befindet,
16schen Sie die schmale Flache und erweitern die iibrigen Fldchen, um den

Spalt zu schlieBen.
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Hinweis

Sie kénnen eine schmale Fldache an der Kante einer Sammelfldche als Splitter

definieren.

So entfernen Sie schmale Flachen:

1. Klicken Sie im Fehlerbeheber mit der rechten Maustaste auf die Diagnose

fiir schmale Flachen, und wihlen Sie im Kontextmenii den Befehl
Problemgeometrie wahlen (Select Problem Geometry).

2. Klicken Sie mit der rechten Maustaste, und wihlen Sie Lé6schen (Delete).
Schlieen Sie den resultierenden Spalt mit Hilfe der Techniken, die im
Abschnitt zu kleinen Schleifen einseitiger Kanten beschrieben wurden.

Wenn Sie Splitter 1dschen, miissen Sie die resultierenden Spalte manuell den
Drahtgittern hinzufligen und die Spalte schlie3en.

Hinweis

Die Priitung auf kleine Fldchen im Spritzguss-Modul von Creo Parametric ist
identisch mit der Priifung auf kleine und schmale Fldchen im Fehlerbeheber von

IDD.
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Erfahrene IDD-Benutzer sollten die erweiterten IDD-Reparatur-Tools von Pro/
ENGINEER Wildfire 4.0 und héher, einschlieBlich Creo Parametric, genauso
verwenden, wie sie die IDD-Reparatur-Tools Pro/ENGINEER Wildfire 3.0 und
Vorgéngerversionen verwendet haben. Neue Benutzer von IDD in Pro/ENGINEER
Wildfire 4.0 und hoher werden beim Einsatz der Reparaturfunktionen von
Vorgéngerversionen wahrscheinlich Schwierigkeiten haben. Daher hat PTC
sichergestellt, dass keine Funktionen von Pro/ENGINEER Wildfire 3.0 und
fritheren Versionen verloren gingen, und gleichzeitig die IDD-Reparatur-Tools in
Pro/ENGINEER Wildfire 4.0 und hoher verbessert.

In diesem Kapitel wird versucht, die gingigen IDD-Reparaturprozesse von Pro/
ENGINEER Wildfire 3.0 und friitheren Versionen den Reparaturprozessen in Pro/
ENGINEER Wildfire 4.0 und héher zuzuordnen. Die IDD-Funktionen in Pro/
ENGINEER Wildfire 4.0 und héher werden ausfithrlich erlautert, die
Funktionalitidt von Pro/ENGINEER Wildfire 3.0 und fritheren Versionen dagegen
nur kurz beschrieben.
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Kante verschieben, um breite Spalte zu
schlieRen

In diesem Handbuch wurde bereits der einfache "Spalte schlieBen"-Prozess
beschrieben, bei dem nach Spalten gesucht wird, die maximale Spaltbreite
festgelegt wird, Spalte dem Drahtmodell hinzugefiigt und die Spalte geschlossen
werden.

Sie konnen mit "Spalte schlieBen" (Zip Gaps) allerdings auch dann keine breiten
Spalte in der Modellgeometrie schlieBen, wenn IDD solche Spalte identifiziert hat.

Pro/ENGINEER Wildfire 3.0 und fruher

Mit den folgenden Techniken konnen Sie breite Spalte im Modell schlieen:

* Projizieren Sie die einwandfreie Kante einer anderen Fliche, die die fehlerhafte
Kante der Fliche ersetzen soll.

* Wenn Sie die Spalte dann immer noch nicht mit "Spalte schlieBen" (Zip Gaps)
schlieBen konnen, unterteilen Sie die fehlerhafte Kante in kleine Segmente und
verschieben diese nahe an die Kante der anderen Fliache, so dass der Spalt klein
genug wird und geschlossen werden kann.

Pro/ENGINEER Wildfire 4.0 und hoher

1. Waibhlen Sie die zu ersetzende fehlerhafte Kante einer Flache aus.

2. Aktivieren Sie im Reparaturmodus das Tool "Ersetzen" (Replace) ().
3. Wihlen Sie eine einwandfreie Kante einer anderen Fliache aus.
Hinweis
Das Unterteilen der Kante in kleine Fragmente ist aufwéindig. Verwenden Sie

stattdessen das Tool "Kurven und Fldchen dndern" (@), um die
Flichenkanten zu verdndern, ohne sie in Fragmente zu unterteilen.

Verwenden Sie das Tool "Kurven und Flachen dndern" wie folgt:

1. Waihlen Sie die zu verandernde fehlerhafte Kante einer Fliache aus.

2. Aktivieren Sie im Reparatur-Modus das Tool "Kurven und Flachen dndern" (

). Das Dialogfenster Kurve dndern (Curve Modify) wird gedffnet.
3. Verdndern Sie die Kante mit Hilfe von Interpolationspunkten.

4. Fiigen Sie die Interpolationspunkte hinzu, und ziehen Sie sie an der Kante der
anderen Fliche an die gewiinschten Positionen.

5. Klicken Sie auf OK.
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Hinweis
In den meisten Féllen werden die Spalte automatisch geschlossen. Falls sie

nicht automatisch geschlossen werden, miissen Sie die fehlerhaften Drahtgitter
entsprechend korrigieren.

Creo Parametric

1. Waihlen Sie die zu ersetzende Kante schlechter Qualitét einer Flache aus.
2. Waihlen Sie auf der Multifunktionsleisten-Registerkarte Import DataDoctor

(Import DataDoctor) die Befehlsfolge Editieren (Edit) » Ersetzen (Replace).

Die Registerkarte Ersetzen (Replace) wird gedffnet. Die ausgewihlte Kante

wird auf der Registerkarte Referenzen (References) dem Kollektor Zu
ersetzendes Element (Item to be replaced) hinzugefiigt.

3. Wihlen Sie eine Kante einer anderen Fliache aus. Die ausgewihlte Kante wird

auf der Registerkarte Referenzen (References) dem Kollektor Ersetzen durch
(Replace with) hinzugefiigt.

4. Klicken Sie auf der Registerkarte Ersetzen (Replace) auf , um die Kante
schlechter Qualitét durch die fiir das Ersetzen ausgewéhlte Kante zu ersetzen.
Die Flache wird basierend auf der ersetzten Kante automatisch geéndert.

Wenn Sie die Geometrie der fiir das Ersetzen ausgewéhlten Flichenkante
definieren mdchten, konnen Sie ihre Interpolationspunkte wie folgt &ndern:

1. Waihlen Sie die Kante der Fldche aus, die Sie dndern mochten.

2. Wihlen Sie auf der Multifunktionsleisten-Registerkarte Import DataDoctor
(Import DataDoctor) die Befehlsfolge Editieren (Edit) > Andern (Modify).
Das Dialogfenster Kurve dndern (Curve Modify) wird ge6ffnet.

3. Wibhlen Sie die Option zum Andern der Flichenkante mithilfe der
Interpolationspunkte aus.

4. Fiigen Sie die Interpolationspunkte hinzu, und ziehen Sie sie an der Kante der
anderen Fliche an die relevanten Positionen.

5. Klicken Sie im Dialogfenster Kurve dndern (Curve Modify) auf OK (OK).

Entfernen zusatzlicher Eckpunkte

Kanten zwischen zwei Flachen kdnnen aus mehreren Segmenten und unnotigen
Eckpunkten bestehen. Sie miissen diese zusétzlichen Eckpunkte nicht entfernen,
um einen Volumenkdrper erzeugen zu konnen. Allerdings kann durch das
Entfernen zusétzlicher Eckpunkte die Qualitdt der Kanten in Bezug auf die
nachgeschaltete Erzeugung von KEs und ihre Verwendung im Spritzguss und der
Fertigung verbessert werden.

Sie konnen die Kantensegmente kombinieren, um die zuséitzlichen Eckpunkte zu
entfernen und die Kantenqualitit der Flichen zu verbessern.
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Pro/ENGINEER Wildfire 3.0 und fruher

Entfernen Sie die iiberschiissigen Eckpunkte mit der Befehlsfolge Geometrie
(Geometry) » Geometrie heilen (Heal Geometry) » Manuell (Manual) »
SammFlaBerand (FixQuiltBndry) » Fertig (Done).

Zusatzliche Eckpunkte vor ihrer Entfernung

Hinweis

Es werden nicht alle zusétzlichen Eckpunkte entfernt, und Sie miissen unter
Umsténden die restlichen iiberschiissigen Eckpunkte manuell entfernen. Um diese
Eckpunkte zu entfernen, bearbeiten Sie die betreffenden Berandungen der beiden
Fléchen und schlieB3en die reparierten Berandungen.

Pro/ENGINEER Wildfire 4.0 und hoher

Sie konnen die Anzeige der Eckpunkte im Reparatur-Modus umschalten, so dass
Sie die zusétzlichen Eckpunkte visuell identifizieren konnen. Das Reparatur-Tool
entfernt zusatzliche Eckpunkte automatisch, wenn Sie Spalte schlieBen und die
zweiseitigen Kanten reparieren. Die zusitzlichen Eckpunkte werden nicht entfernt,
wenn Sie ein Spalt mit dem Reparatur-Tool nicht schlieBen lasst.

Setzen Sie das Reparatur-Tool bei der aktiven Komponente wie folgt ein:
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1. Stellen Sie im Reparatur-Modus sicher, dass die Flachen eingefroren sind und
die Komponente im Geometrie-/Topologie-Strukturbaum (GTS-Baum) aktiv
ist.

Wihlen Sie das Reparatur-Tool aus, und klicken Sie im Schaltpult auf , um
den Schritt abzuschlieen.

0

Zusatzliche Eckpunkte vor ihrer Entfernung

Das Reparatur-Tool entfernt die zusétzlichen Eckpunkte aus den einseitigen und
den zweiseitigen Kanten.

Gehen Sie wie folgt vor, um die zusétzlichen Eckpunkte einzeln zu entfernen:

1. Waihlen Sie zwei aneinander angrenzende Segmente im Modell aus.
2. Wihlen Sie das Werkzeug "Kurve/Drahtg zusammenfiihren" (Merge Crv/Wfm)

=)

Restlicher Eckpunkt nach dem Entfernen zusatzlicher Eckpunkte

Hinweis

Es werden nicht alle tiberschiissigen Eckpunkte entfernt. Sie miissen die restlichen
zusétzlichen Eckpunkte unter Umstidnden manuell entfernen.

Entfernen Sie die iiberschiissigen Eckpunkte wie folgt:
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1. Vergewissern Sie sich, dass eine Komponente aktiv ist, und trennen Sie eine
der Flachen mit einem zusitzlichen Eckpunkt ab.

2. Waihlen Sie die einseitigen Kanten an beiden Seiten des zu entfernenden
Eckpunkts in der Komponente aus.

3. Wibhlen Sie das Werkzeug "Kurve/Drahtg zusammenfiihren" (Merge Crv/Wfm)
&,
4. Aktivieren Sie die abgetrennte Flache.

5. Wibhlen Sie die einseitigen Kanten an beiden Seiten des zu entfernenden
Eckpunkts in der Flache aus.

6. Wibhlen Sie das Werkzeug "Kurve/Drahtg zusammenfiihren" (Merge Crv/Wfm)
(=
7. Vereinen Sie die Fliache und die Komponente.

8. Verkleinern Sie den vereinten Knoten.

Modell, aus dem zusatzliche Eckpunkte entfernt wurden

TN
e T
- e —
H‘“ ;1 I:T \J 7
. _L”_/i | ?L.'

—— !
E Y
fo

V

[ i
1
ST |
g 1 R — —

Creo Parametric

1. Klicken Sie auf der Grafiksymbolleiste auf E, um Eckpunkte, einschlieBlich
der zu entfernenden zusétzlichen Eckpunkte, anzuzeigen.

2. Wihlen Sie Fliachen aus, klicken Sie mit der rechten Maustaste, und wéhlen Sie
im Kontextmenii den Befehl Einfrieren (Freeze) aus, um die ausgewéhlten
Flachen einzufrieren.

3. Klicken Sie im GTS-Baum mit der rechten Maustaste auf die Komponente,
und wihlen Sie im Kontextmenii den Befehl Aktivieren (Activate) aus, um die
Komponente zu aktivieren.

4. Waibhlen Sie die Befehlsfolge Heilen (Heal) »
Registerkarte Reparieren (Repair) wird geoffnet.

Reparieren (Repair). Die

5. Klicken Sie auf der Registerkarte Reparieren (Repair) auf , um Spalte zu
schlieBen und die zusétzlichen Eckpunkte zu entfernen.

™

110 Erste Schritte mit Creo® Parametric Import DataDoctor ™ 2.0



Wenn zusitzliche Eckpunkte {ibrig bleiben, entfernen Sie diese wie folgt:

1. Wihlen Sie die Flache mit einem zusétzlichen Eckpunkt aus, klicken Sie mit
der rechten Maustaste, und wéhlen Sie im Kontextmenii den Befehl Abtrennen
(Detach).

2. Waihlen Sie die einseitigen Flichenkanten an beiden Seiten des Eckpunkts aus.

o
3. Waihlen Sie die Befehlsfolge Editieren (Edit) » Kurven zusammenfiihren
(Merge Curves). Die beiden einseitigen Kanten werden zu einer einseitigen

Kante zusammengefiihrt, und der zusitzliche Eckpunkt wird entfernt.

Eckpunkt korrigieren

Wenn die Endpunkte zwei verbundener Kantensegmente nicht an einem Punkt
zusammentreffen, wird ein fehlerhafter Eckpunkt erzeugt, der sichtbar wird, wenn
Sie den betreffenden Bereich vergrofern.

Pro/ENGINEER Wildfire 3.0 und fruher

Mit den IDD-Funktionen von Pro/ENGINEER Wildfire 3.0 und frither konnen nur
einige wenige Klassen fehlerhafter Eckpunkte korrigiert werden. Die restlichen
Eckpunkte werden als geometrische Priifungen angezeigt, die manuell korrigiert
werden miissen.

Pro/ENGINEER Wildfire 4.0 und hoher

In Pro/ENGINEER Wildfire 4.0 und hoher, einschlie8lich Creo Parametric,
identifiziert IDD automatisch fehlerhafte Eckpunkte, wenn Drahtmodelle wéahrend
des Imports automatisch erzeugt werden. Diese Informationen werden geéndert,
wenn Sie die Drahtgitter bearbeiten. IDD versucht, die fehlerhaften Eckpunkte
wihrend eines Reparatur- oder Angleichen-Vorgangs zu korrigieren. Mit diesem
verbesserten Ansatz werden mehr Eckpunkte repariert als mit der Menii-Manager-
Option Eckpkt beheb (Fix Vertices) aus den Vorgéngerversionen von IDD. Sie
konnen mit dem Fehlerbeheber die restlichen fehlerhaften Eckpunkte identifizieren
und sie von Hand reparieren. Die géngigste empfohlene Reparaturtechnik besteht
darin, alle griilnen Drahtgestelle zu entfernen und den Eckpunkt zu verschieben.

Fehlerhafte Eckpunkte werden auch wihrend Reparaturvorgéingen erzeugt. Wenn
die Eckpunkte der angrenzenden Flachen nicht an einem Punkt zusammentallen,
treffen die schwarzen Drahtgitterkanten scheinbar am Eckpunkt zusammen,
obwohl dies eigentlich nicht stimmt. Um diesen fehlerhaften Eckpunkt zu
korrigieren, transformieren Sie die Fliachen derart, dass sie an einem Punkt
zusammentreffen, und schlieBen Sie das schwarze Drahtgitter.
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Kante gerade machen

Pro/ENGINEER Wildfire 3.0 und fruher

Die IDD-Funktionalitit von Pro/ENGINEER Wildfire 3.0 und friiher verfiigt tiber
einen Befehl, mit dem Sie Kanten gerade machen konnen. Dieser Befehl ist
allerdings in der aktuellen Version von IDD nicht verfiigbar; Sie konnen Kanten
jedoch in Pro/ENGINEER Wildfire 4.0 und hoher gerade machen. Dies ist eine
Kante, die gerade gemacht werden muss.

Pro/ENGINEER Wildfire 4.0 und hoher

1.

112

Erstellen Sie mit dem Tool "UV-Kurve durch Punkte" (UV-Curve through
Points) (@) wie gezeigt eine neue UV-Kurve, die durch die Endpunkte der
fehlerhaften Kante verlauft. Wéhlen Sie in Creo Parametric auf der
Registerkarte Erzeugen (Create) die Befehlsfolge @ UV-Kurven (UV-Curves)

> @ UV-Kurve durch Punkte (UV-Curve through Points), um cine UV-Kurve
zu erzeugen, die durch die Endpunkte der Kante verlauft.

Hinweis

UV-Kurven werden nur innerhalb der Doméne einer Fldche erzeugt. Meist geht
die Flichendomadne tiber die sichtbaren Berandungen der Fliche hinaus, und
die Erstellung der UV-Kurve wird nicht beeintréchtigt. In einigen Féllen
miissen Sie u.U. die Flichendomine mit Editieren (Edit) » Extrapolieren
(Extrapolate) verldngern, um eine UV-Kurve zu erzeugen, die durchgingig ist.

Heben Sie die verzerrte Kante hervor, und wihlen Sie das Tool "Ersetzen"
(Replace) ().

Waihlen Sie die UV-Kurve aus. Die Kante wird gerade gemacht (sieche
Abbildung).
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Hinweis

Wenn die UV-Kurve die Fliche auf der gesamten Léinge schneidet, konnen Sie
sie dem Drahtgitter hinzufiigen, um die Fliche zu trennen, und den
unerwiinschten Teil der Flidche 16schen, statt das Ersetzen-Tool zu verwenden.
Die UV-Kurve (in Blau) ist nach der Ersetzen-Operation nach wie vor
vorhanden und kann bei Bedarf geloscht werden.

Berandung editieren

Pro/ENGINEER Wildfire 3.0 und fruher

Es sind viele Auswahlvorginge erforderlich, um die Kante einer Fliche mit der
IDD-Funktionalitdt von Pro/ENGINEER Wildfire 3.0 und frither zu ersetzen. Sie

miissen die Befehlsfolge Geometrie (Geometry) » Heilen (Heal) » Manuell (Manual)
» Berandung editieren (Edit Boundary) verwenden.

Pro/ENGINEER Wildfire 4.0 und hoher

So ersetzen Sie einen Teil einer Flachenberandung in Pro/ENGINEER Wildfire 4.0
und hoher oder in Creo Parametric:

1. Waibhlen Sie die Kante einer Flache oder eine Kette von Kanten der Flidche aus,
die ersetzt werden soll.

2. Aktivieren Sie das Tool "Ersetzen" (Replace) ().

3. Waihlen Sie die Kante oder eine Kette von Kanten einer angrenzenden Flache
aus, die als Ersatz verwendet werden soll.

UV-Kurven kéonnen manuell fiir die zu trimmende Fliche erstellt und zum Ersetzen
von Kanten verwendet werden. Wenn die ersetzenden Kanten nicht mit den Kanten
iibereinstimmen, die ersetzt werden, konnen Sie diese manuell erzeugten UV-
Kurven verldngern oder kiirzen.

Projizieren und verldngern oder trimmen Sie die UV-Kurve folgendermal3en:

1. Wihlen Sie die Flache, auf der die UV-Kurve erzeugt werden soll.
2. Wihlen Sie das Tool "UV-Kurve durch Projektion" (UV-Curve by Projection) (

). Waihlen Sie in Creo Parametric die Befehlsfolge UV-Kurven (UV-

Curves) » UV-Kurve durch Projektion (UV-Curve by Projection) auf der
Registerkarte Erzeugen (Create) in IDD.
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3. Wihlen Sie die Kante einer anderen zu projizierenden Flache aus. Die
Vorschau der UV-Kurve wird auf der Fliche angezeigt.

4. Klicken Sie mit der rechten Maustaste auf den Endpunkt der UV-Kurve, der
durch ein weiles Feld dargestellt wird, und wéhlen Sie im Kontextmenii den
Befehl Verlangern bis (Extend To).

5. Wibhlen Sie die zu verldngernde Flachenberandung aus.

Hinweis

Die Doméne der Fliche ist fiir die gewiinschte UV-Kurve nicht gro3 genug, wenn
die UV-Kurve nicht bis zur fraglichen Position verldngert wird oder wenn die
Vorschau der UV-Kurve nicht vollstindig auf die Fldche projiziert wird. Klicken

Sie auf Editieren (Edit) » Extrapolieren (Extrapolate), um die Doméne der Fldche
zu erweitern, wenn sie fiir die Erweiterung der UV-Kurve nicht gro3 genug ist.

Nachdem die UV-Kurven erzeugt wurden, gehen Sie folgendermal3en vor:

1. Wihlen Sie die zu ersetzenden Kantensegmente.

2. Aktivieren Sie das Tool "Ersetzen" (Replace).

3. Waihlen Sie die UV-Kurven aus, um die neue Kante zu definieren.

Hinweis

Solange die UV-Kurven die Fliche vollstindig schneiden, wird die Fldche durch
diesen Prozess getrimmt.

In einigen Fillen ist es einfacher, die Fliche zu trennen und den nicht
erforderlichen Teil der Fliche zu l6schen. Gehen Sie hierzu folgendermaf3en vor:

1. Erzeugen Sie die UV-Kurve, um die Flache zu trennen.

2. Vergewissern Sie sich, dass die UV-Kurve noch hervorgehoben ist, und wéhlen
Sie das Tool "Zu Drahtgitter hinzufiigen" (Add to Wireframe) (.) In Creo

Parametric ist die Befehlsfolge . Zu Drahtmodell (Wireframe) » . Zu
Drahtmodell hinzufiigen (Add to Wireframe) auf der Registerkarte Bedingung
definieren (Constrain) in IDD verfiigbar.

3. Loschen Sie den Teil der Flache, der nicht erforderlich ist.
So 16schen Sie die gesamte Fldchenberandung:
1. Trennen Sie die Flache von der Komponente ab.

2. Waihlen Sie die zu entfernenden Kantensegmente.

3. Klicken Sie mit der rechten Maustaste, und klicken Sie auf Léschen (Delete),
oder driicken Sie die Delete-Taste.

Hinweis
Die unberandete Flichendoméne wird dargestellt.
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In Pro/ENGINEER Wildfire 4.0 und hoher kénnen Sie mit dem Tool "Trimmen"
(Trim) im Modus zum Erzeugen von KEs die Berandung einer Fldche dndern,
indem Sie die Fliche trimmen. In Creo Parametric ist das Tool "Trimmen" (Trim)
auf der Registerkarte Editieren (Edit) in IDD verfiigbar.

Flachenseite umkehren

Gelegentlich wird beim Import einer Flache der falsche Teil einer periodischen
Flache beibehalten, dies gilt insbesondere fiir zylindrische oder sphérische Flachen.
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Die Reparatur ist einfacher, wenn Sie die Berandung der Fldche aus angrenzenden
Flachen neu erstellen. So korrigieren Sie den falschen Teil einer periodischen
Flache:

1. Trennen Sie die Fldche von der umgebenden Sammelfliche ab.

2. Isolieren Sie die abgetrennte Fliche, damit die Bildschirmdarstellung nicht zu
uniibersichtlich wird.

3. Loschen Sie die Berandung der sichtbaren Fliche.

4. Wihlen Sie die unberandete Flache aus, klicken Sie auf Editieren (Edit) »
Extrapolieren (Extrapolate), und ziehen Sie die Kanten der Fliche, bis diese

den gewlinschten Flacheninhalt umfasst.
5. Aktivieren Sie die unberandete Flache.

6. Erzeugen Sie UV-Kurven auf der unberandeten Fliche, indem Sie die Kanten
der angrenzenden Fliche wie folgt projizieren:

a. Waihlen Sie die unberandete Flache und anschlieBend das Tool "UV-Kurve
durch Projektion" (UV-Curve by Projection) aus.

b. Halten Sie die STRG-Taste gedriickt, wéhrend Sie die sichtbaren Kanten
der angrenzenden Flachen auswéhlen.

c. Klicken Sie auf .
7. Fiigen Sie die UV-Kurven wie folgt dem Drahtgitter hinzu:

a. Legen Sie den Auswabhlfilter auf UV-Kurven fest.

b. Ziehen Sie einen Rahmen tiber die sichtbaren UV-Kurven, um alle
auszuwéhlen.

c. Waihlen Sie das Tool "Zu Drahtgitter hinzufligen" (Add to Wireframe).
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8.
9.

Wihlen Sie den unerwiinschten Teil der Flache aus, und 16schen Sie ihn.

Ziehen Sie die korrigierte Fldche zuriick in die Sammelfldche bzw. schneiden
Sie die korrigierte Fliache aus, und fiigen Sie sie in die Sammelflache ein.

In einigen Fillen umfasst die Fliche Schleifen, die nicht von anderen Flachen
projiziert werden konnen. So korrigieren Sie den falschen Teil einer periodischen
Flache in diesen Fallen:

I.
2.

AN AN S

10.
1.

12.
13.
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Trennen Sie die Fliche von der umgebenden Sammelfldche ab.

Isolieren Sie die abgetrennte Flache, damit die Bildschirmdarstellung nicht zu
uniibersichtlich wird.

Kopieren Sie die Fliche, und fiigen Sie sie als neue Fldche ein.
Blenden Sie die neue Fliche aus.
Ldschen Sie die Berandung der sichtbaren Fliche.

Wihlen Sie die Flache aus, klicken Sie auf Editieren (Edit) » Extrapolieren
(Extrapolate), und ziehen Sie die Kanten der Flache, bis diese den gewiinschten

Flacheninhalt umfasst.

Blenden Sie die kopierte Flache ein.

. Erzeugen Sie UV-Kurven auf der unberandeten Flache, indem Sie die Kanten

der kopierten Flache wie folgt projizieren:

a. Waihlen Sie die unberandete Flache und anschlieBend das Tool "UV-Kurve
durch Projektion" (UV-Curve by Projection) aus.

b. Halten Sie die STRG-Taste gedriickt, wéhrend Sie die sichtbaren Kanten
der kopierten Flache auswéhlen.

c. Klicken Sie auf .

Loschen Sie die kopierte Flache, oder blenden Sie sie aus.
Aktivieren Sie die unberandete Fléache.

Fiigen Sie die UV-Kurven wie folgt dem Drahtgitter hinzu:
a. Legen Sie den Auswahlfilter auf UV-Kurven fest.

b. Ziehen Sie einen Rahmen iiber die sichtbaren UV-Kurven, um alle
auszuwiabhlen.

c. Waihlen Sie das Tool "Zu Drahtgitter hinzufiigen" (Add to Wireframe).
Wihlen Sie den unerwiinschten Teil der Flache aus, und 16schen Sie ihn.

Ziehen Sie die korrigierte Flache zuriick in die Sammelfldche bzw. schneiden
Sie die korrigierte Fliche aus, und fiigen Sie sie in die Sammelfldche ein.

™
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Die Uberbauen-Technik

Verwenden Sie die Uberbauen-Technik, um fehlerhafte Flichen mit Singularititen
zu reparieren. Diese Technik ist auch in Pro/ENGINEER Wildfire 4.0 und
Nachfolgeversionen sowie in Creo Parametric einsetzbar.

Sie konnen mit dem Fehlerbeheber fehlerhafte Flachen identifizieren. Sie miissen
die Singularitdt in der fehlerhaften Flache finden, bevor Sie mit der Reparatur
beginnen. Schlagen Sie hierzu den Abschnitt "Fehlerhafte Flichen" im Kapitel
"Fehlerbeheber - Analyse- und Reparaturverfahren" dieses Handbuchs nach.

Wenn eine Singularitdt innerhalb der Berandung einer Flache vorliegt, gehen Sie
folgendermallen vor:

1. Erstellen Sie UV-Kurven, die durch Punkte auf der fehlerhaften Flédche
verlduft, um die Singularitét zu isolieren.

Hinweis
Stellen Sie sicher, dass die UV-Kurven vier Seiten mit rechteckigen Ecken

erzeugen. Ordnungsgemalle Flachen haben vier Seiten. Dreiseitige Fldchen
kénnen zu neuen Singularititen fiihren.

2. Fiigen Sie die UV-Kurven dem Drahtgitter hinzu.
3. Loschen Sie den fehlerhaften Teil der Fliche.

4. Erzeugen Sie eine neue Berandungsverbundfldche. Stellen Sie sicher, dass alle
vier Kanten der neuen Berandungsverbundflache eine stetige Kriimmung
aufweisen.

5. Ziehen Sie die neue Flache in die Sammelfliche bzw. kopieren Sie die neue
Flache, und fiigen Sie sie in die Sammelflache ein.

Moglicherweise miissen Sie die umgebenden Flachen trimmen, wenn sich die
Singularitét in der Ecke der Flache befindet. In anderen Féllen miissen Sie die
mathematischen Eigenschaften einer Fliche dndern, um die Singularititen zu

entfernen.

AbschlieRende Kommentare

Wir hoffen, dass Sie mit diesem Erste Schritte-Handbuch zu Import DataDoctor
eine Einfiihrung in die leistungsstarken Tools zur Datenreparatur und
-wiederverwendung von Import DataDoctor erhalten haben. In diesem Handbuch
wurden verschiedene Methoden vorgefiihrt, um dhnliche Ziele zu erreichen.
Weitere Informationen finden Sie in der Creo Parametric Hilfe.
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In diesem Kapitel finden Sie Informationen zu allen Quellen, von denen Sie
Unterstiitzung beim Arbeiten mit Creo Parametric beziehen konnen. Die drei
Hauptanlaufstellen sind:

* Creo Parametric Hilfe-Center

* Creo Parametric 1.0 Ressourcencenter

» Technischer Support

* PTC Trainingsabteilung

« PTC Benutzer-Community

Wenn Sie sich mit diesen Quellen vertraut machen, werden Sie feststellen, dass
sich Themengebiete haufig iiberschneiden. Fiir den Zugriff auf die PTC

Dokumentation iiber das Internet ist ein PTC Online-Konto erforderlich. Er6ffnen
Sie ein PTC Online-Konto unter www.ptc.com/appserver/common/account/basic.

Jsp.
Hinweis
Zum Lesen von PDF-Dateien ist Adobe Acrobat Reader erforderlich. Von der

Adresse http://get.adobe.com/reader/ kénnen Sie eine kostenlose Version von
Acrobat Reader herunterladen.


https://www.ptc.com/appserver/common/account/basic.jsp
https://www.ptc.com/appserver/common/account/basic.jsp
http://get.adobe.com/reader/

Creo Parametric Hilfe-Center

Sie konnen auf die kontextbezogene Creo Parametric Hilfe und Biicher im PDF-

Format zugreifen, indem Sie in Creo Parametric auf Hilfe (Help) > Hilfe-Center
(Help Center) klicken oder die kontextbezogene Hilfe aufrufen. Im Hilfe-Center

finden Sie weitere Informationen unter Das Hilfe-Center verwenden.

Creo Parametric Ressourcencenter

Webbasierte benutzerfreundliche Tools konnen Sie beim Erlernen von Creo
Parametric unterstiitzen. Greifen Sie auf das Creo Parametric 1.0 Ressourcencenter
vom Creo Parametric Browser aus, iiber das Creo Parametric Hilfe-Center oder
unter www.ptc.com/community/landing/creo-elements-pro/start.htm zu. Die Tools
beinhalten Folgendes:

*  Web-Tools und Lernprogramme — Schrittweise Anleitungen und weitere
hilfreiche Themen. Navigieren Sie vom Ressourcencenter aus zu den
Lernprogrammen, oder 6ffnen Sie gleich www.ptc.com/appserver/mkt/
products/home.jsp?k=403, und wihlen Sie das Ressourcencenter oder Demos,
Tools und Lernprogramme aus » .

* Kurzreferenz — Handliche Referenz fiir Symbolleisten, Auswahlmethoden,
dynamisches Anzeigen usw.

* Tools zur Produktivitatssteigerung — Eine interaktive Anleitung fiir neue Tools
zur Steigerung Threr Produktivitit. Darin enthalten sind die Auswahl-Tools,
Verbesserungen der Anzeigewerkzeuge (3D-Drehen, Verschieben und
Zoomen) und der Modellbaum.

*  Menu Mapper — Querverweise von Meniibefehlen von Pro/ENGINEER 2001
und Pro/ENGINEER Wildfire auf die aktuellsten Menubefehle.

PTC Technical Support

Technischer Support fiir Creo Parametric ist rund um die Uhr verfligbar. Sie
konnen sich telefonisch, per Fax, E-Mail oder FTP an den technischen Support von
PTC wenden.

Sie konnen von Creo Parametric einfach auf die neuesten Kontaktinformationen
fiir den technischen Support zugreifen, indem Sie auf der Startseite im Creo
Parametric Browser auf den Link Support klicken.

PTC Trainingsabteilung

Die PTC Trainingsabteilung bietet eine Vielzahl von Losungen an, die die
Precision Learning-Methode einbeziehen. Precision Learning besteht aus einem
fortlaufenden Zyklus mit den Phasen Training — Assessment — Fortschritt, bei dem
die richtigen Personen zum richtigen Zeitpunkt das richtige Training erhalten.

™
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Ob Sie einen Kurs unter der Leitung eines erfahrenen, von PTC zertifizierten
Kursleiters mit Branchenkenntnissen besuchen oder einen PTC Web-Kurs
absolvieren, der Lernstoff wird nach der Philosophie "Tell Me, Show Me, Let Me
Do" theoretisch und praktisch vermittelt, um Verstindnis und Lerntiefe zu
maximieren. Unter www.ptc.com finden Sie eine grofle Auswahl von Schulungen
und Web-Kursen, die von der PTC Trainingsabteilung angeboten werden (klicken
Sie auf Consulting & Training » PTC University).

Die PTC Trainingsabteilung bietet eine Vielzahl flexibler Losungen an. Die
Auswahl an PTC Schulungen beinhaltet u.a.:

* Malgeschneiderte Kurse — Kurse werden auf die individuellen Bediirfnisse
Ihres Unternehmens zugeschnitten. Themen, die fiir die Situation in Threm
Unternehmen irrelevant sind, werden ausgeklammert.

* Training vor Ort — PTC schickt einen Kursleiter in Ihr Unternehmen und stellt
tiber unsere mobilen Laptop-Center die Rechner zur Verfiigung.

Die Beurteilung des Lernerfolgs ist der Schliissel zur Planung einer effizienten
Schulung. Auflerdem kdnnen Sie so bewerten, ob sich Thre Trainingsinvestitionen
gelohnt haben. Mit dem Pro/FICIENCY Evaluator konnen Sie eine prizise und
objektive Bewertung IThres personlichen, abteilungs- und firmenspezifischen
Kenntnisstands vornehmen.

Der Pro/FICIENCY Evaluator zeigt Bereiche auf, in denen Thr Designteam seine
Kenntnisse ausbauen kann. Dabei konnen Sie auf webgestiitztes Training (kurze,
praxisnahe Themen auf den PTC Kundensupport-Webseiten), Biicher, Mentoring
etc. zurlickgreifen.

Creo Parametric Benutzer-Community

Pro/USER bietet Neuigkeiten und Informationen fiir Benutzer von PTC Software
an. Auf der jahrlichen internationalen Pro/USER Konferenz werden Seminare
abgehalten. Unter www.ptcuser.org finden Sie eine Liste mit Trainingsseminaren.
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